Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore
for additional books and resources.
### Chapter 3 / Viewing Reports
- Overview of the Reports Workspace ............................................ 53
- Open a Report ........................................................................... 54
- Search Reports ........................................................................ 54
- Create a Report Folder ............................................................... 56

### Chapter 4 / Process Management
- Introduction to Process Management ........................................ 58
- View an Active Process ............................................................. 61
- Working with Tasks ................................................................... 62
- View Process Status on a Tablet ............................................... 69

### Chapter 5 / Viewing Content from the SAS Information Delivery Portal
- Log On to SAS Financial Management ....................................... 75
- Access SAS Financial Management Content from the Portal ...... 76
- The Form Status Dashboard Portlet ........................................... 77
- Display Alerts in the SAS Information Delivery Portal ............... 79
- Run SAS Financial Management Reports ................................. 80

### PART 2 The SAS Financial Management Add-In for Microsoft Excel

### Chapter 6 / Getting Started with the Excel Add-In
- Overview of the SAS Financial Management Add-In for Microsoft Excel ......................................................... 85
- Accessing the Excel Add-In .......................................................... 85

### Chapter 7 / Viewing Financial Reports ............................................. 87
Chapter 11 / Cell Protection ................................................................. 137
  About Cell Protection ................................................................. 137
  Adding Cell Protection Directly to a Form .................................. 138

Chapter 12 / Hold Rules ................................................................. 139
  Designing Holds for Data-Entry Forms ...................................... 139

Chapter 13 / Supplemental Schedules ............................................. 147
  Entering Data into a Supplemental Schedule ............................... 147

Chapter 14 / Forecasting ............................................................... 151
  Generating a Forecast ............................................................ 151

Index ............................................................................................... 153
Using This Book

Audience

This book is intended for the following audience:

- users who manage forms
- users who edit or approve forms
- users who view financial reports

If you are an administrator or a power user, also see the SAS Financial Management: Process Administrator’s Guide.
What’s New in SAS Financial Management 5.4

Overview

SAS Financial Management 5.4 includes the following changes and new features.

Process Management

Process Management is a new SAS web application that is displayed with the Adobe Flash Player. A process manager can define, view, and manage the processes that are specific to a company from a central location. Some examples of processes are month-end close, a rolling forecast, and budgeting. The tasks in a process follow a workflow that is created in the process definition. Process management also supports user notification at the process and task levels, commenting, and audit history.

- The workflow can be composed of both manual and automatic tasks.
- Process viewers can view the tasks in a process. Task owners can take action on an active task.
- Tasks are given a due date that is relative to the process date. They can also be scheduled to occur at a specific time on the due date.
In SAS Financial Management Studio, administrators can create tasks for the process workflow, using wizards such as Load Model Data.

Administrators can write a stored process that can be run from a task.

On a tablet, users can check the status of a process and take action on a task.

Data Entry and Report Creation

In reports and data-entry tables, users can filter, rank, and sort data. A data-entry table is read-only while any of these options are applied.

In web data entry, users can create or remove a sort; they can temporarily remove or restore ranking or data filters.

Visibility rules hide values from display in forms and reports. The rules can be defined for a model or a form set. These rules are intended to hide data that is not necessary or not of interest. They are not intended to provide data security.

System filters are now implemented via visibility rules. Filters from a previous release are converted to visibility rules during the migration process.

If a user hides a member using visibility rules and later pivots the table, the filter still applies. If the filter affects only selected cells, they are displayed as empty gray cells.

A new Custom Analytics wizard enables users to select and run a custom stored process that is integrated with SAS Financial Management data.

Previously, information maps that were generated by SAS Financial Management had static hierarchies. Now the hierarchies are dynamic and are updated when the information map (or SAS Web Report Studio report) is opened.

In the SAS Financial Management Add-In for Microsoft Excel, if a user is logged on to a SAS Financial Management server from another report and opens a report from the desktop, no logon is necessary. The logon credentials are shared.

A new CDA function returns cell comments that can be included in an Excel report.
- The requirements for time member rules have changed. A data-entry table can contain a fixed time member rule or a floating time member rule. A read-only table can contain a fixed time member rule or one or more floating time member rules, which cannot overlap.

- Operational planning is no longer supported.

The following features apply only to data entry:

- Cell protection rules are now honored in all middle tier operations, including automatic allocation, forecasting, and driver formulas.

- Via hold rules, cells can be protected against indirect changes, such as allocation and consolidation.

- Form data is evaluated on submission (or on request) to ensure that it passes validation. The validation rules are defined in SAS Financial Management Studio at the model level or the form set level.

- The Delay writeback until refresh table property has been replaced by Intelligent writeback. This option delays sending data to the server for a specified interval without data entry, unless a refresh action takes place. The interval is also set in the table properties.

  For bottom-up form sets, Intelligent writeback is the default option. For top-down form sets, this option is disabled; data is sent to the server immediately.

- In a supplemental schedule, users can copy and paste detail records.

- Top-down forms (as well as bottom-up forms) can be submitted without first being edited.

---

**SAS 9.4 Support**

SAS Financial Management 5.4 is released on the first maintenance release of SAS 9.4. SAS 9.4 contains key enhancements including an embedded middle-tier web application server and support for only 64-bit Windows environments.
Web Application Server Support

SAS Financial Management 5.4 no longer requires or supports external third-party application servers (JBoss, WebSphere, and WebLogic). Some of the benefits of this new feature include the following:

- cost reduction by eliminating external application servers
- higher availability by eliminating remote services
Accessibility Features of SAS Financial Management

Overview

SAS Financial Management has been tested with assistive technology tools. It includes accessibility and compatibility features that improve the usability of the product for users with disabilities. (Some accessibility issues remain and are noted below.) These features are related to accessibility standards for electronic information technology that were adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973 (2008 draft proposal initiative update). Applications are also tested against Web Content Accessibility Guidelines (WCAG) 2.0, part of the Web Accessibility Initiative (WAI) of the Worldwide Web Consortium (W3C). For detailed information about the accessibility of this product, send e-mail to accessibility@sas.com or call SAS Technical Support.

Documentation Format

Please contact accessibility@sas.com if you need this document in an alternative digital format.
Landmarks

Landmarks are references to the primary areas of an application’s user interface. They provide a quick and easy way for keyboard users to navigate to these areas of the application.

To access the list of landmarks that are available for a specific context, press Ctrl+F6 to open the Landmarks window. Use the arrow keys to select a landmark, and then press Enter to navigate to that area of the application.

Themes

An application’s theme is the collection of colors, graphics, and fonts that appear in the application. The following themes are provided with this application: SAS Blue Steel, SAS Corporate, SAS Dark, SAS High Contrast, and SAS Light. To change the theme for the application, select File ➤ Preferences, and go to the Global Preferences page.

You can use keyboard shortcuts to magnify the contents of the browser window or to invert the application colors. For more information, see <XREFSEE THE Keyboard Shortcuts SUBTOPIC BELOW>.

Note: If you have special requirements for your themes, then contact your system administrator or visual designer about using the SAS Theme Designer for Flex application to build custom themes. SAS Theme Designer for Flex is installed with SAS themes. For more information about this tool, see see Table A. on page xvii..

Keyboard Shortcuts

The following table contains the keyboard shortcuts for the application. In the user interface, the shortcuts are displayed within parentheses in tooltips and menu labels.
Note: Some application-level keyboard shortcuts do not work when you first open an application. When that happens, press Tab to move the focus to the application, and then try the keyboard shortcut again.

Note: When you use a keyboard shortcut to activate a button, move the focus to the field or section that the button is associated with before you use the keyboard shortcut. For example, if a table has an associated button, you must first move the focus to the table before you press Ctrl+?.

### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
</table>
| Open a Help pop-up window from the button. | Ctrl+?  
**Note:** This shortcut does not work on some keyboards (for example, the Italian keyboard). |
| Zoom in. | Ctrl+plus sign |
| Zoom out. | Ctrl+minus sign |
| Reset the zoom state. | Ctrl+0 |
| Maximize view (collapses the category pane and the tile pane, and hides the status bar and the application bar, which includes the menu bar and the workspace bar). or Exit maximized view (expands the category pane and the tile pane, and shows the status bar and the application bar). | Ctrl+Alt+Shift+M  
**Note:** This shortcut does not work when the focus is on the workspace bar. |
| Open a pop-up menu. | Shift+F9 (if a menu is available in that context)  
**Note:** If you use Shift+F9 to display the pop-up menu, then it is always displayed in the top left corner of the user interface control that you are using. |
<p>| Open the Landmarks window. | Ctrl+F6 |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temporarily invert or revert application colors (for the current session only).</td>
<td>Ctrl+~</td>
</tr>
<tr>
<td><strong>Note:</strong> You can set the <strong>Invert application colors</strong> preference in the Preferences window if you want the color change to persist across sessions.</td>
<td></td>
</tr>
<tr>
<td>Rename the selected tab.</td>
<td>Make sure that the focus is on the tab. Press F2, and specify the new name. To commit your changes, press Enter. To cancel your changes, press Esc.</td>
</tr>
<tr>
<td>Close the selected tab.</td>
<td>Make sure that the focus is on the tab, and then press Delete.</td>
</tr>
<tr>
<td><strong>Note:</strong> Some tabs cannot be closed.</td>
<td></td>
</tr>
<tr>
<td>Switch in and out of Edit mode for a table cell.</td>
<td>To enter Edit mode, select a cell, and press F2.</td>
</tr>
<tr>
<td>To exit Edit mode, press Esc.</td>
<td></td>
</tr>
<tr>
<td>Navigate between table headings and table content.</td>
<td>For a two-dimensional table, make sure that the focus is on the table and that you are not in Edit mode. Press Ctrl+F8 to switch the focus between column headings and table cells. Use the arrow keys to navigate from heading to heading. For a multidimensional table, make sure that the focus is on a table cell and that you are not in Edit mode. Press Ctrl+F8 to switch the focus between column headings, row headings, and table cells. Use the arrow keys to navigate from heading to heading.</td>
</tr>
<tr>
<td>Task</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Navigate the content rows of a table.       | When table cells are in Edit mode:  
  • Press Tab and Shift+Tab to move from cell to cell horizontally across columns.  
  • Press Enter and Shift+Enter to move from cell to cell vertically across rows.  
  When table cells are not in Edit mode, use the arrow keys to move from cell to cell. |
| Sort columns in a table.                     | To sort a single column, navigate to its column heading (press Ctrl+F8). Press the spacebar to sort the column.  
  To sort additional columns, navigate to the column heading of each additional column that you want to sort. Press Ctrl+spacebar. |
| Change the width of the current column.      | Navigate to the column heading (press Ctrl+F8). Then press Ctrl+left arrow or Ctrl+right arrow to change the width of the column. |
| Move the current column.                     | Navigate to the column heading (press Ctrl+F8). Then press Shift+left arrow to move one column to the left, and press Shift+right arrow to move one column to the right. |
| Automatically re-size the current column to fit its contents. | Navigate to the column heading (press Ctrl+F8). Then press Enter. |

**Exceptions to Accessibility Standards**

Exceptions to accessibility standards are documented in the following table.

**Note:** The JAWS issues occur when JAWS is used with Internet Explorer. Other browsers were not tested with JAWS, unless noted.
**Exceptions to Accessibility Standards**

<table>
<thead>
<tr>
<th>Accessibility Issue</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sometimes, you cannot use the keyboard to sequentially navigate through the interface and move the focus in a meaningful order.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>The SAS High Contrast theme has a few unresolved focus and contrast issues.</td>
<td>For contrast issues, select a different theme, and then press Ctrl+~ to invert the colors.</td>
</tr>
<tr>
<td>The SAS Light theme and SAS Dark theme might not provide sufficient color contrast for some users.</td>
<td>Use the SAS Corporate theme or the SAS High Contrast theme.</td>
</tr>
<tr>
<td>JAWS cannot read some of the controls in the application, such as images, icons, and buttons.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>JAWS cannot read the tooltips of items in trees, lists, and menus.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>JAWS refers to table controls as list boxes.</td>
<td>When JAWS reports that a control is a list box, keep in mind that it might actually be a table.</td>
</tr>
<tr>
<td>JAWS can sometimes read controls that have been disabled.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>Sometimes, JAWS does not correctly work with the controls in the Preferences window.</td>
<td>When you are in Virtual PC cursor mode in JAWS, traverse the entire window to familiarize yourself with its contents before you change any of the settings. You might need to switch between Forms mode and Virtual PC cursor mode to access all of the controls.</td>
</tr>
<tr>
<td>JAWS does not correctly read the states in a tri-state check box tree if JAWS is not in Forms mode.</td>
<td>Disable the JAWS Virtual PC cursor when you work with the check box tree. Tab to the tree, and press Insert+Z to disable the Virtual PC cursor. When you finish interacting with the tree, press Insert+Z to re-enable the Virtual PC cursor.</td>
</tr>
<tr>
<td><strong>Accessibility Issue</strong></td>
<td><strong>Workaround</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>The keyboard shortcuts that are used to interact with editable tables can conflict with keyboard shortcuts for the Forms mode in JAWS.</td>
<td>As a best practice, disable the JAWS Virtual PC cursor when you work with tables. Tab to the table, and press Insert+Z to disable the Virtual PC cursor. When you finish interacting with the table, press Insert+Z to re-enable the Virtual PC cursor.</td>
</tr>
<tr>
<td>JAWS cannot read two-column property tables.</td>
<td>No workaround is available.</td>
</tr>
</tbody>
</table>
| JAWS does not correctly read the information in a table:  
  - JAWS cannot read the column headings of a table.  
  - When table cells are not editable and the focus is on the body of the table, JAWS reads an entire row at a time instead of cell by cell.  
  - When table cells are editable and the focus is on the body of the table, JAWS reads only the first row of the table. If you use the arrow keys to select a cell or row, then JAWS does not read anything. If you press Enter to edit a cell, then JAWS reads the row that contains the edited cell. | No workaround is available. |
<p>| When a table cell is selected and you press Home, End, Page Up, or Page Down, the focus moves to the first displayed column, regardless of which column you were in. | Use the arrow keys to navigate through the cells of the table. |
| You cannot use the keyboard to scroll to the left and the right in some tables. | No workaround is available. |
| You cannot use the keyboard to activate the links within how-to topics and Help pop-up windows. | Use the Help menu to access the linked documents. |</p>
<table>
<thead>
<tr>
<th>Accessibility Issue</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>You cannot use Shift+F10 to open a pop-up menu.</td>
<td>Use Shift+F9 to open pop-up menus that are created for the SAS application. The generic menu that is provided by the Flash player cannot be opened by Shift+F9.</td>
</tr>
<tr>
<td><strong>Note:</strong> If you press Shift+F10 in Internet Explorer and no context menu is available, the browser moves the focus to the <strong>File</strong> menu for the browser tab. To return focus to the application area of the browser window, press Esc.</td>
<td></td>
</tr>
<tr>
<td>You cannot use the keyboard to access the close (x) button that is in the top right corner of a tab.</td>
<td>Make sure that the focus is on the tab, and then press Delete to close the tab.</td>
</tr>
<tr>
<td>You cannot use the keyboard to access the close (x) button that is in the top right corner of a tile in the tile pane.</td>
<td>Make sure that the focus is on the tile, and then press Delete to close the tile. (The object that is displayed in the tile is not deleted.)</td>
</tr>
<tr>
<td>Visual focus for the menu bar is indicated with an outline around the entire menu bar instead of around individual menus.</td>
<td>To select individual menus, use the left or right arrow key.</td>
</tr>
<tr>
<td>Sometimes, you cannot use the Tab key to move the focus to the application area of a web browser (that is, the part of the browser window that is controlled by the Flash player).</td>
<td>The following workaround is applicable to Internet Explorer only. Press Ctrl+<em>number</em>, where <em>number</em> is the ordinal position of the application’s tab in the set of tabs that are open in your browser window. Then press Tab to move the focus to the application area.</td>
</tr>
<tr>
<td>You cannot use the Tab key to move the focus outside of a code or expression editor. Pressing Tab within the editor only inserts tabs.</td>
<td>For Internet Explorer, press Shift+F10, and then press Esc to move the focus outside of the editor. For Firefox, press Alt+Tab to switch to another application. When you switch back, the focus will be outside of the editor.</td>
</tr>
<tr>
<td>You cannot use Ctrl+Alt+Shift+M to minimize or maximize the view if the focus is on the workspace bar.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>Accessibility Issue</td>
<td>Workaround</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>If you tab to an item that is partially or entirely off-screen, the item is not automatically scrolled back into view.</td>
<td>Sometimes, you can use the arrow keys or the Tab key to scroll the item back into view.</td>
</tr>
<tr>
<td>When you use the Ctrl+plus sign keyboard shortcut to zoom in, some portions of the interface can become hidden from view.</td>
<td>Use the keyboard to access the hidden parts of the interface.</td>
</tr>
<tr>
<td>The Ctrl+plus sign and Ctrl+minus sign keyboard shortcuts for zooming in and out do not work on some menus unless the menus are first opened.</td>
<td>Open the menu before you use the keyboard shortcut.</td>
</tr>
<tr>
<td>The Ctrl+plus sign and Ctrl+minus sign keyboard shortcuts for zooming in and out do not work on all elements in the application window (for example, tooltips and button labels).</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>If you maximize a tile in the Home workspace and then use the Tab key to navigate, the focus appears to be lost after you tab away from the Log Off button.</td>
<td>After you tab away from the Log Off button, press the Tab key 5 more times to return the focus to the maximized tile.</td>
</tr>
<tr>
<td>You cannot use the keyboard to navigate in the Layout section because it is a Read-Only interface that is used for the visual verification of the elements that have been created.</td>
<td>Use the test button that is in the Layout section to preview your elements in a secondary window. The items that are displayed in the secondary window are identical to the items that are displayed in the Layout section, but unlike the items in the Read-Only Layout section, you can interact with the items in the secondary window. Note: After the application opens the secondary window, press Tab to move the focus to the window.</td>
</tr>
<tr>
<td>JAWS cannot read the labels for the Red, Green, and Blue fields in the Custom Colors window.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>Accessibility Issue</td>
<td>Workaround</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>You cannot use the keyboard to access the color blocks in the Recently used section of the color selection control.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>JAWS does not explain how to open a drop-down menu or drop-down list.</td>
<td>Press Ctrl+down arrow to open the control.</td>
</tr>
<tr>
<td>When JAWS reads the control names in a breadcrumb, it does not distinguish between the breadcrumb buttons that contain drop-down menus and those that do not.</td>
<td>Check for a drop-down menu by pressing Ctrl +down arrow on a breadcrumb button. A drop-down menu will open if one exists for that button.</td>
</tr>
<tr>
<td>When you use the down arrow to scroll through the items in a &quot;combo box,&quot; any item that opens a secondary window will do so when you scroll down to it. This will prevent you from navigating to items that are farther down in the drop-down list.</td>
<td>Press Ctrl+down arrow to scroll through the items in the drop-down list, and then press Enter or Tab to make a selection.</td>
</tr>
<tr>
<td>When you add a date value to the predefined list for a date element, you cannot use the keyboard to access the date-selection button in the table cells in the Customize Data window for the predefined list.</td>
<td>Type the date value in the field that is next to the date-selection button.</td>
</tr>
<tr>
<td>JAWS cannot read the contents of a tree table (that is, a table that contains a tree) unless the table is in Edit mode.</td>
<td>Make sure that the focus is in the tree table, and press F2 to enter Edit mode.</td>
</tr>
<tr>
<td>JAWS cannot read the &lt;name-of-UI-control&gt;.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>JAWS cannot read the content selection tree.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>Sometimes, after you close a tab to hide it from view, you can still use the keyboard to access the contents of the tab.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>After you edit or delete a comment, the focus does not return to the comment.</td>
<td>Use the Tab key to return the focus to the comment.</td>
</tr>
<tr>
<td>Accessibility Issue</td>
<td>Workaround</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>If the list of additional search options contains a secondary level of options, you cannot use the keyboard to select the check boxes that are associated with that secondary level of options.</td>
<td>No workaround is available.</td>
</tr>
</tbody>
</table>
Part 1

SAS Financial Management on the Web

Chapter 1
Managing Forms ................................................................. 3

Chapter 2
Editing a Form in the Forms Workspace ........................................ 23

Chapter 3
Viewing Reports .................................................................... 53

Chapter 4
Process Management ............................................................. 57

Chapter 5
Viewing Content from the SAS Information Delivery Portal .............. 75
Managing Forms

Forms and Form Sets ................................................................. 4

The Forms Workspace ............................................................ 5

Select Preferences ..................................................................... 8

Working with Forms ................................................................. 8
  Receive an Alert Notification ................................................. 8
  View Available Forms .......................................................... 9
  Tasks in the Forms Workspace ............................................... 9
  Capabilities for Working with Forms ..................................... 10

Open a Form ............................................................................. 10

Select a View ........................................................................... 10

Select Columns for Display ..................................................... 12

Sort the Display of Forms ....................................................... 13

Search the Form Display ......................................................... 13
  Create a Search .................................................................... 13
  Manage Searches .................................................................. 14

View Form History .................................................................... 14

Act on One or More Forms ..................................................... 15

Add a Comment to a Form ....................................................... 16

Open an Attachment ............................................................... 17
Forms and Form Sets

Users enter data through forms that have been designed by a form administrator and published to the web. Here is an example form:

A form set is a collection of forms. It has a target hierarchy (for example, a hierarchy of organizational departments or managers, or a hierarchy of accounts). This example reflects a geographical organization:
Each form is associated with a member of the target hierarchy. The target hierarchy helps determine the workflow—the order in which forms are edited and reviewed.

For more detailed information, see “More about Forms and Form Sets” on page 17.

---

**The Forms Workspace**

In the Forms workspace of SAS Financial Management, you can manage and edit forms. The workspace is laid out as follows:

1. **File** menu, including **Recent work** and **Preferences**.
2. **Help** menu, including How-to topics and important links.
3. Workspace tabs:
   - Forms workspace: for managing and editing forms.
- Reports workspace: for finding and opening financial reports in Microsoft Excel or in a PDF.
- Administration workspace: for viewing security information. This workspace is available only to administrators.
- Processes workspace: for viewing and working with an active process.

Click a tab to view that workspace.

4 Number of forms in the list, as well as the current search text and options.

5 Category pane. When you are editing a form, click Forms to return to the forms display without closing any open forms.

Use the Expand » or Collapse « button to display or hide the category pane.

6 Forms workspace toolbar, including these items:
  - Refresh button ↩.
  - Open in Excel button 📑. Use this button to edit a form in Microsoft Excel.
  - Expand all button 🍃, for expanding the hierarchical display. (Hierarchy view only.)
  - Collapse all button 🍃, for collapsing the hierarchical display. (Hierarchy view only.)
  - Sort button 🔢, for sorting the display by multiple columns.
  - Manage columns button 📊.
  - Open menu 📐. Click Open to open the form in the default menu. Use the drop-down list to make additional selections.
  - Select view menu 🆕. Use this menu to specify how to display the forms, as a list (Grid view) or as a tree (Hierarchy view).

7 Headings for the list of forms. Click a column heading to sort the display by a single column. Click a column or the direction button 🔢 to reverse the sort order.
8 Forms that are currently available to you. Double-click a form to open it, or use the Open menu.

9 At the bottom of the page is the tile pane, with a minimized view of the forms that you have open. Click a form to display it.

To display more than one form at a time, click View and make a selection.

10 Status bar, including results of workflow actions.

11 The Maximize view button hides header information, to make more room for the form display.

12 Details pane, containing the following sections:
   - **Workflow** section, for taking action on a form
   - **Comments** section, for viewing or adding comments to a form
   - **Attachments** section, for opening form attachments
   - **History** section, for viewing a form’s history and status

Use the Expand or Collapse button to display or hide the details pane.

13 Drag bar for controlling how much of the details pane is visible.

14 Search options:
   - Enter text in the search box.
   - Click the Additional search options button to open a box in which you can filter the display.
   - Click Save Search to save or manage searches.

15 **Log Off** or **Portal**.

If you reached SAS Financial Management from the SAS Information Delivery Portal, the Portal link returns you to the portal, where you can log off.

**Note:** When you log off or return to the portal, your workspace settings are saved, including column selections and the open or closed status of panes and sections within panes. Your current forms filter is also saved.
Select Preferences

To modify your preferences for working with SAS Financial Management, select File ▶ Preferences. In the Preferences window, you can make the following selections:

- the locale (region and language) for viewing the display.
- the theme for the display. Themes specify items such as colors and fonts.
- the workspace that appears first when you log on to SAS Financial Management.
- the number of items to display in the File ▶ Recent Work list of forms.
- whether to display icons, labels, or both.

**TIP** To increase the size of the display, press CTRL/+. To decrease the size of the display, press CTRL/-. To restore the original display size, press CTRL/0.

Working with Forms

Receive an Alert Notification

When a form is available for you to work on, you receive an alert notification. The notification can be delivered in various ways, including the following:

- an e-mail message
- a text message
- a notification in the Alerts portlet of the SAS Information Delivery Portal

**TIP** To select the notification types that you prefer, select Options ▶ Preferences in the portal.
The alert notification contains information about a form. For example, the form is available, has been rejected, or is nearing its deadline. An e-mail notification also contains two links to the Forms workspace. One link populates the search field with the form name. The other link displays all the forms that are available to you.

**View Available Forms**

To view available forms, select one of the following options:

- In a web browser, log on to SAS Financial Management and select the Forms workspace.
- In a web browser, log on to the SAS Information Delivery Portal. In the Alerts portlet, click an alert notification link.
- From an e-mail message, click a link to the Forms workspace.

**Tasks in the Forms Workspace**

The Forms workspace displays the forms that you are responsible for and that are available for editing or review. (Form administrators can view all available forms.)

If you are a form author, you edit a form and then send the form on to the next person in the workflow. If you are a form reviewer, you open the form, review its contents, and either approve or reject it, sending it on to the next person in the workflow.

Depending on your role and the form’s type and status, you can perform these tasks:

- Open a form for viewing or editing.
- Modify the form display.
- Filter the display.
- Take action on a form.
- View form history.
- Comment on a form or view existing comments.
- View a document that is attached to a form.
Capabilities for Working with Forms

To be assigned as a form author or reviewer, you must have the appropriate capabilities. If you can't access a form, check with your administrator to make sure that you have the capabilities that you need.

Open a Form

You open a form for editing or review from the Forms workspace. Use one of the following methods:

- Double-click the form name or select **Open** to open the form in the default editor. Forms can be edited within the Forms workspace (web data entry) or in Microsoft Excel. The form administrator determines which options are available. If both options are available, then web data entry is the default.

- Select **Open ➤ Send to Tile Pane** to place a minimized version of the forms in the tile pane.

- Select **Open ➤ Add** to add the selected forms to the current layout.

- Click the Open in Excel button ![Excel](image) to open the form in Microsoft Excel. This option is available only if the form administrator has enabled it for this form set. Within Excel, you can edit the form online or check out the form for offline editing.

Select a View

With the **Select View** menu ![Select View](image), you can select either a grid view or a hierarchy view for the forms display.

**Grid** view displays a simple list of forms.
To change the columns that are selected or the order in which they appear, click the Manage Columns button. (This option applies only to grid view.)

**Hierarchy** view displays forms in hierarchical order within each form set.

To expand the entire display, click the Expand all button. To expand only part of the display, right-click a node and select Expand all.

To collapse the display, use the Collapse all button or right-click a node and select Collapse all.

In both grid view and hierarchy view, the display includes only the forms that your capabilities and form-specific assignments entitle you to edit or review.

To ensure that the display is current, click the Refresh button. Refreshing the page adds any forms that were published after you opened the page, removes any forms that were withdrawn from publication, and reflects any status changes to forms. The current filter settings still apply.
Select Columns for Display

In both grid view and hierarchy view, the display can include the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>In grid view, the arrow indicates the direction of the workflow (bottom-up or top-down).&lt;br&gt;bottom-up form&lt;br&gt;top-down form&lt;br&gt;In hierarchy view, this column also indicates the form’s level in the hierarchy. Click the column heading to reverse the ordering of forms.</td>
</tr>
<tr>
<td>Member</td>
<td>This column contains the name or description of the member of the target hierarchy that the form is assigned to. Typically, this is the name of an organization in an organization hierarchy.&lt;br&gt;Click the name of the target member to open the form in the default editor. If the form can be opened in both the Forms workspace or Microsoft Excel, the default is the Forms workspace.</td>
</tr>
<tr>
<td>Name</td>
<td>This column contains the name of the form set that the form belongs to.</td>
</tr>
<tr>
<td>Status</td>
<td>This column displays the form’s current status, such as Edited or Pushed.</td>
</tr>
<tr>
<td>Deadline</td>
<td>This column contains the date that the form is due, displayed in your time zone.&lt;br&gt;If the deadline has passed, the due date has a warning flag 🔴.</td>
</tr>
</tbody>
</table>

**TIP** Some forms are locked when the deadline is reached. A locked form is removed from the display. If you have a form open for editing, its status changes to read-only.

**See Also**
- “Bottom-Up Form Sets” on page 18
Sort the Display of Forms

To sort the display of forms alphabetically by a single column, click the column heading. For example, you might want to sort the available forms by the dates they are due. To reverse the alphabetical order within a column, click the arrow next to the column name.

Note: In hierarchy view, sorting affects only the top hierarchical level of each form set.

In grid view, you can also sort the forms by multiple columns, as follows:

1. Click the Sort button.

2. In the Sort window, select the columns on which to sort, as well as their precedence and the order of the sort (ascending or descending).

Search the Form Display

Create a Search

To search the available forms, enter some text in the Search box:

If a value in any of the columns matches the search filter, the form is included. In hierarchy view, if a subordinate form is a match for the search filter, all parent forms are displayed as well.

To clear the search text, click the Clear search button to the right of the search text.

Note: This button does not clear the additional search options.
To specify additional criteria, click the Show additional search options button. You can filter the search by status and deadline.

To restore the default search options (All), click the Clear search button.

**Manage Searches**

To save search criteria, click the drop-down box to the left of the search box and select **Save Search**.

The saved search filter includes the additional criteria such as form type. After saving a search filter, you can select it from the same drop-down box instead of re-creating it each time.

To reorder or delete search filters, click the drop-down box to the left of the filter box and select **Manage Saved Searches**.

You can’t modify the search name or contents.

---

**View Form History**

Information about a form is available in the **History** section of the details pane.
The following information is included:

- the status, member, and name of selected forms. Click the Deselect button to deselect a form.
- form authors and reviewers. Click the e-mail button next to an author or reviewer’s name to create an e-mail message to send to that person.
- form history, including the user and date for each action.

If a form is checked out for offline editing in Microsoft Excel, the Action column displays that information. (To undo the check-out, select Undo Check-out from the Workflow section.)

### Act on One or More Forms

The Workflow section of the details pane displays all actions that are currently available for the selected form. Click a button such as Submit. In the pop-up window that appears, you can enter a comment.

If the action completes successfully, the form is sent to the next stage in the workflow and an alert notification is sent to all users who are associated with that stage. For example, if you submit a bottom-up form, an alert notification is sent to that form’s reviewers. If you entered a comment, it is included in the alert notification text of e-mailed alerts.

If you select multiple forms, the Workflow section displays any actions that the selected forms have in common:
To remove a form from the **Workflow** section, click the Deselect button ✗.

After you perform an action, click **Workflow results** in the status bar at the bottom of the page. If the action failed for some reason, the workflow results log explains why.

See Also

- “The Bottom-Up Workflow” on page 18
- “The Top-Down Workflow” on page 19

### Add a Comment to a Form

In the **Comments** section of the Forms workspace, you can add a comment to a form, view comments, and reply to existing comments.

To add a comment:

1. Select a form.
2. In the **Comments** section, enter a topic name. On the line beneath it, enter the comment.
Note: The first line in the Comments section is a search box. To filter comments, enter a search string and press Enter.

3  (Optional) To attach a document to the comment, click the Attach a file button.

4  Click Post.

Note: Form comments are available to all users of that form and to all form administrators.

Open an Attachment

If your form administrator has attached any files to the form set, the files are available as attachments in the Forms workspace.

Select a form. In the Attachments section of the details pane, click an attachment to open it.

More about Forms and Form Sets

This section contains background information about form sets, workflows, form actions, and form status.
Bottom-Up Form Sets

The Bottom-Up Workflow

The route that a form takes is determined by the form set's workflow. In a bottom-up form set, data is entered at the lowest hierarchical level that is defined in the form set. When the data entry for a form is complete, the author submits the form set to the reviewer for either approval or rejection. For each form level, data is entered, submitted to the next level up for approval, and aggregated if approved. If a form is rejected, it might be returned to the previous author for additional editing.

The workflow ends when one of the following actions occurs:

- The form set is locked. The form set might be locked automatically when its deadline is reached, or a form administrator might lock the form set manually.
- A form administrator completes the form set (even if the flow of data has not reached the top of the hierarchy).

Parent and Child Forms

A parent form cannot be submitted for review until all the child forms that contribute data to it have been approved. If you are responsible for submitting a parent form and you also have sole responsibility for approving all its child forms, then you can submit the parent form as soon as all the child forms have been submitted for review.

You can enter data into a parent form if the data-entry table includes the virtual child of the parent member that the form is assigned to. Enter the data in association with the virtual child. The parent form then aggregates its virtual child data along with the data coming from the forms that are its real children. For an explanation of virtual children, see “Virtual Children” on page 30.

Bottom-Up Form Status

A bottom-up form can have the following status values:
<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![checkmark] Approved</td>
<td>The form has been submitted for review and has been approved by all required reviewers.</td>
</tr>
<tr>
<td>![cloud] Checked out</td>
<td>The form has been checked out for offline editing in Microsoft Excel.</td>
</tr>
<tr>
<td>![checkmark] Edited</td>
<td>The form has been edited but has not yet been submitted for review.</td>
</tr>
<tr>
<td>![partially approved]</td>
<td>The form has been submitted for review and has been approved by some but not all required reviewers.</td>
</tr>
<tr>
<td>![cloud] Rejected</td>
<td>The form has been submitted for review and has been rejected by one of its reviewers.</td>
</tr>
<tr>
<td>![checkmark] Submitted</td>
<td>The form has been submitted for review but has not yet been approved or rejected.</td>
</tr>
<tr>
<td>![cloud] Unedited</td>
<td>The form has not yet been edited, or one of its subordinate forms has been removed from the workflow.</td>
</tr>
</tbody>
</table>

**Top-Down Form Sets**

**The Top-Down Workflow**

In a top-down form set, data-entry proceeds down the target hierarchy. If you are the author for the top-level form, you enter all the amounts that will cascade down the target hierarchy for the workflow. To do this, you manually enter data into crossings that include the virtual child of the top member in the target hierarchy. Then you allocate those amounts to one or more lower levels of the target hierarchy. When the data entry is complete, you use the **Push** action to move the form to the next level down in the form set hierarchy.

**Note:** When you edit a form using the SAS Financial Management Add-In for Microsoft Excel, an Allocation wizard is available. During web data entry, allocations are manual.

Pushing a form does not change the amounts that were entered by the author. It only makes the subordinate forms accessible to the next set of form authors. If you are the
form author at the next level in the target hierarchy, you allocate the data that you received and push it down another level.

You can enter an amount that is less than or equal to the allocated amount. Any difference is returned to the parent’s virtual child member. You can also spread allocated amounts to siblings of the allocated crossing’s dimension members. The total amount allocated must be the same or less than the original amount allocated. At the lowest level of the target hierarchy, you cannot allocate, but you can use the **Spread** option to redistribute those amounts.

**Note:** If you are the author of a form that has descendants, you can allocate amounts to all lower levels and then use the **Push to All** action to bypass any further allocations.

The workflow ends when one of the following actions occurs:

- The form set is locked. The form set might be locked automatically when its deadline is reached, or a form administrator might lock the form set manually.
- A form administrator completes the form set (even if the flow of data has not reached the bottom of the hierarchy).

**Top-Down Form Status**

A top-down form can have the following status values:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>☑ Completed</strong></td>
<td>The form has received an allocation of data as a result of a <strong>Push to All</strong> action on a higher-level form. The result of the allocation can be viewed but not changed.</td>
</tr>
<tr>
<td><strong>✍ Edited</strong></td>
<td>The form has been edited but has not yet been pushed. A form also has this status if it was pushed but then recalled.</td>
</tr>
<tr>
<td><strong>☐ Holding</strong></td>
<td>The parent form has not yet been pushed. The form cannot be edited yet. Forms with Holding status are shown only to form administrators.</td>
</tr>
<tr>
<td>Status</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pushed</td>
<td>The form has either been pushed down a level or pushed to all its descendants. If the form was pushed down a level, then the data that was allocated to the form's children when the form was edited has been copied into the child forms. If the form was pushed to all its descendants, then the data that was allocated to the form's descendants when the form was edited has been copied into the descendant forms.</td>
</tr>
<tr>
<td>Unedited</td>
<td>The form has not yet been edited.</td>
</tr>
</tbody>
</table>
Editing a Form in the Forms Workspace

Overview of Web Data Entry ......................................................... 24

Form Display ................................................................. 25
  Dimensions and Crossings ....................................................... 25
  Rows, Columns, and Slicers ..................................................... 26
  Expand or Collapse a Row or Column ....................................... 27
  Drill Down into a Row or Column ........................................... 27
  Make Slicer Selections .......................................................... 27

Entering Data ................................................................. 28
  Writable and Non-Writable Cells ............................................. 28
  Enter Data and Refresh the Display ......................................... 29
  Hierarchies and Parent Members ............................................ 29
  Virtual Children ............................................................... 30
  Enter Data Directly into Parent Cells ....................................... 30
  Data Entry with Hold Rules .................................................. 31

Copy and Paste Cells ........................................................ 32

Spread Values across a Range of Cells ..................................... 32
  Overview of the Spread Option .............................................. 32
  Spread Values ................................................................. 33
  Spread Patterns from Existing Cells ....................................... 36
  If the Target Range Includes Protected Cells ............................ 38

Adjust Cell Values ............................................................ 38
  Overview ................................................................. 38
  Adjust Values by Multiplier .................................................. 39
Overview of Web Data Entry

In the Forms workspace, you can enter data into the currently selected form. A data-entry form contains one or more data-entry tables. A form can also contain read-only tables to provide the user with additional information.

During web data entry, you can perform these operations:

- View data.
- Enter data into writable cells.
Enter data in a supplemental schedule, if the form contains one.

Copy and paste values from one range of cells to another.

Distribute values across a range of cells, using a **Spread** operation.

Modify values in a range of cells, using the **Adjust Values** operation.

Enter or view comments that are associated with a cell crossing or with the form.

Temporarily modify a table’s layout.

View cell information.

Run validation rules over the data-entry tables in the form.

Sort the data in a data-entry table or read-only table.

Temporarily remove ranking or data filtering from a data-entry table or read-only table.

Take action on the current form. For example, submit the form or approve it.

If you select one or more data cells and right-click, a pop-up menu appears. The options on the pop-up menu depend on the cells that you selected.

---

**Form Display**

**Dimensions and Crossings**

Dimensions are used to categorize data values (for example, by time, product, account, and customer). Each numeric value in a SAS Financial Management table belongs to a crossing that consists of one member from each dimension that is represented in the table.

The dimension members tell you what the numeric value in a data cell represents. For example, one cell’s dimension members might tell you that the numeric value represents the actual revenue for an Italian subsidiary in October 2011, expressed in euros. Another cell’s dimension members might tell you that the numeric value
represents the planned salary expense for a Japanese subsidiary for fiscal year 2012, expressed in yen.

**Rows, Columns, and Slicers**

By default, the slicer dimensions are displayed in the header above a data-entry table.

![Slicers](image)

Use the **Show** menu to select the information that is displayed:

![Show Menu](image)

While you are editing a form, you can make changes to the display, such as the following:

- changing the position of a dimension. For example, a dimension that is currently displayed in a row can be displayed in a column or can become a slicer. To change a dimension’s position in the table:
  - Drag a dimension to a different position in the table header.
  - Alternatively, open the drop-down menu for a dimension and change its position.
- expanding or collapsing the hierarchy in a row or column.
- drilling down into the hierarchy in a row or column.
- selecting different slicer members.

These changes persist only while you are editing the form. If you close the form and reopen it, the display reverts to the original form design.
Expand or Collapse a Row or Column

To expand the hierarchy display in a row or column, click the Expand button 📊. Click the Collapse button ⏯️ to collapse the display again.

**Note:** As you scroll down or across in a large table, the row and column headings remain stationary. Only the data cells move.

Drill Down into a Row or Column

To drill down into a hierarchy, click the Drill button 🔽. The table header automatically displays the drill path for the expanded hierarchy. To drill back up in the hierarchy, click a member in the drill path.

Make Slicer Selections

In a slicer, you select one member of a hierarchy to apply to the display, in effect creating a slice of the data. Rows and columns can display multiple members of a hierarchy, but all the data cells in the table are associated with the selected slicer member.

For each slicer, the table header displays the selected member. To select a different member, click the dimension or member in the table header. The Select Member window is displayed, and you can make a different selection:

![Select Member Window](image)

To change the position of a slicer, click the drop-down button at the right of the slicer display and make a selection:
For more information about hierarchies, see “Hierarchies and Parent Members” on page 29.

## Entering Data

### Writable and Non-Writable Cells

To view information about a cell in a data-entry table, right-click the cell and select **Cell Information**. The pop-up text contains information about the cell’s readability and writability.

Another indicator is the color of a cell. Cell colors depend on your theme selection. The table below shows the default cell colors for the SAS Corporate theme:

### Table 2.1  Default Cell Colors

<table>
<thead>
<tr>
<th>SAS Corporate Theme</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Green Cell" /></td>
<td>This cell is writable. You can enter data into it, and it can be the target of a <strong>Spread</strong>, <strong>Adjust Values</strong>, or <strong>Paste</strong> operation.</td>
</tr>
</tbody>
</table>
| ![Light Green Cell](Image) | This cell is read-only. It might contain a parent member, a calculated member, or a protected member, or it might be subject to data security. You can view the cell’s contents but you cannot enter data into it.  
 **Note:** In some form sets, parent cells are writable.  
 If the cell is empty, it is subject to visibility rules or a filter member combination and is not readable or writable. |
| ![Red Cell](Image) | A red cell is not readable or writable. You might not be authorized to view its contents, or its contents might be invalid.  
 If no cells in the current rows and columns are readable, or if a data filter returns no rows, the data-entry table contains a single red cell. |
### SAS Corporate Theme

<table>
<thead>
<tr>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>This cell is not writable because its value comes from a supplemental schedule.</td>
</tr>
<tr>
<td>This cell has been placed on hold. You can enter data into it directly, but it is protected from indirect changes such as allocations and consolidations.</td>
</tr>
<tr>
<td>This cell is protected, and it is also covered by hold rules. You cannot enter data into it directly, and it is also protected from indirect changes such as allocations and consolidations.</td>
</tr>
</tbody>
</table>

**Note:** If no cells in a data-entry table are writable, a sort, ranking, or data filter might be applied.

### Enter Data and Refresh the Display

Values can be entered into a writable cell. In some cases, there is a slight delay and you can enter multiple values before the data is saved and the display is refreshed. This feature enhances performance. If the feature is not enabled, the data is saved immediately. (This behavior depends on the form set design.)

To explicitly refresh the display, click the Refresh button. Other actions, such as changing a slicer value, closing the form, or validating data, also trigger a refresh.

The refresh operation saves the data, formats recently entered numeric values, and recomputes values that depend on the new data. For example, the data that you enter into a cell might trigger a calculation that affects other cells.

**Note:** A refresh operation does not save data that is in a supplemental table. For that, you must select **Save supplemental data**.

### Hierarchies and Parent Members

Hierarchies are tree structures that consist of parent-child relationships. A dimension contains one or more hierarchies, each of which can include some or all of the members of the dimension.
Here is an example of a hierarchy, or part of a hierarchy, in the Account dimension:

In data entry, you enter typically enter data in leaf members (members that have no subordinate members). Those values are added together and displayed at (roll up to) the parent member. In the example above, the values for items such as Rent, Electric, and Water would roll up to Facilities. The values for Facilities, Other, Postage, and Office Supplies would roll up to Administrative Expense, and so on.

A few members might not roll up to the parent member. That behavior is determined by the member properties.

Virtual Children

A virtual child (VC member) is automatically assigned to any member that has child members that roll up to it. In a data-entry table, the virtual child is a writable member whose values contribute to the parent member. If the VC member is displayed in the table, you can use it to enter data for the parent without associating that data with a specific child member.

Virtual children are available in all hierarchical dimensions except the Time and Source dimensions.

Enter Data Directly into Parent Cells

Note: These options apply only to forms in a bottom-up workflow.
In most cases, a parent cell is read-only. Its value is derived from the values of its subordinate members. If a parent cell is designed to be writable, it is displayed in yellow. When you enter data into a writable parent cell, the value is distributed in one of these ways:

- It is written to the virtual child (VC) member for the parent. (Does not apply to the Time dimension.)
- It is allocated to eligible subordinate cells.

These options are set by the form designer.

**Data Entry with Hold Rules**

**Note:** This feature applies only to bottom-up form sets.

If a cell in a data-entry table is being held, it is protected from indirect changes such as allocations and consolidations. For example:

- If the hold is on a leaf cell, and you write to its parent cell, the leaf cell gets no allocation from the parent.
- If the hold is on a parent cell, and you write to one of the descendant (leaf) cells, the change in value is subtracted from the other descendant cells. The parent value stays the same.

You can enter a value directly into a held cell. It is also available as a target of actions such as paste, **Spread**, and **Adjust Values**.

For more information, see “Data Entry with Hold Rules” on page 95.

**See Also**

- “Copy and Paste Cells” on page 32
- “Spread Values across a Range of Cells” on page 32
- “Adjust Cell Values” on page 38
- “Supplemental Schedules” on page 49
Copy and Paste Cells

You can copy a range of cells and paste their values into another range of cells. The target cells must all be writable.

To copy cells:

1. Select a range of cells.
2. Right-click and select **Copy Cells**.

To paste the values of the copied cells:

1. Select a range of cells with the same size and shape.
2. Right-click and select **Paste Cells**.

Spread Values across a Range of Cells

Overview of the Spread Option

Use the **Spread** option to spread values over a selected range of cells at the same level of the hierarchy. The spread can be horizontal or vertical.

In a horizontal spread, the values are spread from left to right. The source cells are in the leftmost column of the range.
**Spread Values across a Range of Cells**

**Figure 2.1  Horizontal Spread**

In a vertical spread, the values are spread from top to bottom. The source cells are in the topmost row of the range.

**Figure 2.2  Vertical Spread**

**Spread Values**

To spread values to a range of cells:

1. Select a range that includes both the source and target cells. The source cells must already contain the amounts that you want to spread.
   
   **Note:** The range cannot include a writable parent cell. (If the parent cells are not writable, they are skipped by the spread operation.)

2. Right-click and select **Spread**.

3. In the Spread window, select a spread direction, **Horizontal** or **Vertical**.

4. Select a spread pattern. Possible patterns are as follows:

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spread amounts evenly</td>
<td>Values are distributed evenly among the target cells.</td>
</tr>
</tbody>
</table>
### Spread using weights

Each relative weight represents a percentage of the whole (100%), and target cells receive that percentage of the amount.

### Spread using a 13–week account period

The pattern that you select is applied as weights. For example, with the 4,4,5 pattern, the first two months are considered to contain 4 weeks and receive 4/13 of the amount. The third month is considered to have 5 weeks and receives 5/13 of the amount. The pattern is repeated for any remaining months in the target rows or columns.

**Note:** This pattern is available only when you spread over Time.

### Spread using percentages

This pattern is similar to the relative weight pattern. Instead of weights, you assign a percentage of the amount to target rows or columns. Percentages must total 100%.

### Select cells to base a spread pattern on

This pattern is similar to the relative weight pattern. In this case, the weights come from a range of cells that you select from a single row or column. See “Spread Patterns from Existing Cells” on page 36.

If you select a pattern other than **Spread amounts evenly**, the spread pattern section displays the first row or column in the target range and boxes for the pattern values. If you are entering weights, it also displays the corresponding percentages.
5 If the pattern that you specify is shorter than the range of target cells, the pattern is repeated (for weights) or distributed evenly (for percentages).

6 From the **Spread these amounts using** drop-down list, select a method for handling existing values in the target cells.

For example, assume that you are performing a horizontal spread across three cells with values of 6, 0, and 9. You choose to spread the source amount (6) evenly. The results depend on the option that you select:

<table>
<thead>
<tr>
<th>Original values</th>
<th>Option</th>
<th>Resulting values</th>
</tr>
</thead>
<tbody>
<tr>
<td>6, 0, 9</td>
<td><strong>Keep existing values</strong></td>
<td>3, 3, 9</td>
</tr>
<tr>
<td></td>
<td>If a target cell already has a value, it is not affected by the spread.</td>
<td></td>
</tr>
<tr>
<td>Original values</td>
<td>Option</td>
<td>Resulting values</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>6, 0, 9</td>
<td><strong>Override the existing values with the spread result</strong>&lt;br&gt;Existing values are ignored.</td>
<td>2, 2, 2</td>
</tr>
<tr>
<td>6, 0, 9</td>
<td><strong>Add the spread result to the existing values</strong></td>
<td>2, 2, 11</td>
</tr>
<tr>
<td>6, 0, 9</td>
<td><strong>Add the spread result to the sum of the existing values, then spread the result</strong>&lt;br&gt;The values of the target cells are added to the value to be spread. Then the sum is spread to the target cells.</td>
<td>5, 5, 5</td>
</tr>
</tbody>
</table>

7. Before you click **OK**, you can click **Preview** to view the effects of your selection. If you are not satisfied with the results, select a different pattern.

**Spread Patterns from Existing Cells**

To select a spread pattern from existing cells:

1. In the Spread window, choose **Select cells to base a spread pattern on**.<br>   The Custom Pattern window is displayed.

2. From the table, select a range within a single row or column to act as the pattern.<br>   The range can be longer or shorter than the target range, and it can be either horizontal or vertical, regardless of the spread direction.

3. Click anywhere in the table in the Custom Pattern window.
4 If you click **Return to Spread**, the values in your selection are applied as weights in the spread pattern. If the pattern is shorter than the target, the weights are repeated. You can modify these weights in the **Spread** window.

5 To select a different range of cells as a pattern, click the **Select Cells** button 📊.
If the Target Range Includes Protected Cells

If you spread a source value over a range that includes both protected and unprotected cells, the protected cells are not changed. The entire source value is divided among the unprotected cells. Here are some examples:

- You spread a source value of 24 evenly over four cells. The second cell is protected. The other three (unprotected) cells each receive a third of the source value, giving each cell a value of 8. The second cell is unchanged.

- You spread a source value of 20 over four cells. The second cell is protected. You use the relative weights 1, skip, 2, 2. (You cannot assign a weight to a protected cell.) The second cell receives no distribution. The other three cells receive 4, 8, and 8, respectively.

Adjust Cell Values

Overview

Use the Adjust Values option to change the values in selected cells:

1. Select a range of cells.
   
   Note: The range that you select cannot contain a read-only cell, a protected cell, or a parent cell.

2. Right-click and select Adjust Values.

3. In the Adjust Values window, select the type of adjustment (multiplier, fixed value, or proportional value) and enter an adjustment amount.

The Total selected value field displays the sum of the values in the selected cells. The Total adjusted value field displays the sum of those values after adjustment.
Adjust Values by Multiplier

To multiply the value in each selected cell by a specified value:

1. In the Adjust Values window, select **By multiplier**.

2. Enter the multiplier in the adjacent field. It can be positive or negative.
   The value of each cell is multiplied by the number that you enter.

Adjust Values by a Fixed Amount

To change the value in each selected cell by a fixed amount:

1. In the Adjust Values window, select **By value**.
2 Enter the amount in the adjacent field. The amount can be positive or negative. This value is added to each selected cell.

Adjust Values by a Proportional Amount

To allocate an amount to the selected cells in proportion to their original values:

1 In the Adjust Values window, select **By value**.

2 Enter the total amount to allocate in the adjacent field.

3 Select the **Modify each cell proportionately** check box.

Here are some examples of proportional adjustment, each example affecting two cells:

<table>
<thead>
<tr>
<th>Original Values</th>
<th>Adjustment</th>
<th>Resulting Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 and 10</td>
<td>3</td>
<td>6 and 12</td>
</tr>
<tr>
<td>5 and 10</td>
<td>-3</td>
<td>4 and 8</td>
</tr>
<tr>
<td>(5) and (10)</td>
<td>3</td>
<td>(4) and (8)</td>
</tr>
<tr>
<td>(5) and (10)</td>
<td>-3</td>
<td>(6) and (12)</td>
</tr>
</tbody>
</table>
Note: Proportional adjustment is not possible if the selected range of cells contains both positive and negative values. In these cases, the Modify each cell proportionately check box is not available.

---

### Attach Comments to a Cell

#### Overview

A cell comment consists of text that you attach to a single data cell in a form that you are editing or reviewing. A cell comment is associated with the cell crossing.

Note: For information about adding comments to an entire form, see “Add a Comment to a Form” on page 16.

#### Add a Comment

To add a comment to a cell:

1. Select a cell.
   
   Note: The cell does not need to be writable. However, if you are denied Read access to a cell, you cannot add or view any comments for that cell.

2. In the Cell Comments section of the details pane, click Add Comment and enter the comment.

   ![Comment dialog box](image)

   Note: If the ability to add comments is not available for your form, you can view existing comments, but you cannot add new comments.
3 If the comment is for your personal use, select This comment is private. Otherwise, depending on the form set settings, the comment is available in other forms or reports.

Keep in mind that you cannot go back later and change the comment’s privacy setting. For example, to make a public comment private, you must delete the comment and re-create it.

**View Cell Comments**

To view cell comments:

1 Select a cell with a red flag in its upper right corner.

Any comments that are associated with that crossing appear in the Cell Comments section. Your private comments include a locked comment icon.

2 If you also want to see comments that are associated with subordinate members, select Show Contributing Comments Indicator. In the table, select a cell with a blue flag.

All comments that are associated with that crossing, including subordinate members, appear in the Cell Comments section. If a comment has replies, the number of replies appears in parentheses after the comment subject.

3 Use the Expand and Collapse buttons to expand or collapse the display of comments and replies.

From the action menu, you can reply to a comment, edit the most recent comment or a reply, sort the replies, or delete comments or replies.

**Note:** Unless you are an administrator, you can delete only your own comments and replies. If a reply from someone else is attached to your comment, you can’t delete your comment.
View the Crossing for a Comment

To view the crossing for a comment:

1. Expand the Crossing folder.

2. If you click the Switch to this crossing button, the display changes to reflect the crossing that is associated with this comment.

3. Click Return to original view to go back to the previous display.

   Note: If you modified the display (for example, by rearranging columns, rows, or slicers), clicking this button might not take you to the original view.

Sorting, Ranking, and Filtering

Overview

Tables in a form can be affected by sorting, ranking, and data filters. When a sort, ranking, or data filter is applied to a data-entry table, the table is in a read-only state.

You can add a sort, or you can cancel a sort that was applied to the form template or a form using the SAS Financial Management Add-in for Microsoft Excel. Your selections apply while the form is open.

You can temporarily remove a ranking or data filter that was applied via the Excel add-in. However, you can’t add, modify, or permanently remove ranking or filtering.

Sorting

The Sort option enables you to sort the data in a read-only table or data-entry table by the values in a single row or column.

You can apply the sort to the entire table. In this example, the user is sorting on Postage.
You can also sort the data within a group. In this example, the columns contain nested dimensions: Product and Analysis. The user has chosen to sort on Postage, grouped by Product:

To sort the data in a table:

1. Make sure that all the members that you want to sort are displayed on the table.
   The sort applies only to members that are currently displayed.

2. Right-click a row or a column heading.
   If there is more than one row or column dimension, select a member of the innermost dimension.

3. Select Sort ➤ Ascending or Sort ➤ Descending.
   The display is sorted according to the values in that row or column. A sort direction icon indicates the direction of the sort. To reverse the direction, click the sort direction icon.
If the other axis contains two or more headings, you can sort the members within a group by selecting **Sort ➤ Ascending ➤ dimension-name** or **Sort ➤ Descending ➤ dimension-name**.

For **dimension-name**, select an outer dimension.

**Note:** Member properties and custom properties cannot be used as grouping criteria.

To cancel a sort, right-click any row or column heading and select **Sort ➤ None**.

**Ranking**

Ranking consists of displaying, in order, the top or bottom data values in a row or column. This example displays the top four values for Postage. Notice that the Product hierarchy is flattened.

![Displaying the top 4 values of CW_Account:Postage](image)

Ranking can also be done within a group. This example displays the top Postage value for each product:
To view the ranking criteria, move your mouse pointer over the icon above the table.

You can temporarily remove the ranking from a table. Click anywhere in the table and select **Rank ▶️ Remove**. To restore the ranking, select **Rank ▶️ Restore**.

If ranking is applied to debit accounts, the top-ranked values are the ones with the highest debit values, regardless of how those values are displayed. If ranking is applied to credit accounts, the top-ranked values are the ones with the highest credit values.

**Note:** Instead of displaying the top or bottom $n$ values in a row or column, a ranking might display the cells that contain the top or bottom $n$ percent of the total value in a row or column. For example, with values of 2, 4, 6, 8, and 10, a ranking of top 50% would return 8 and 10. A ranking of bottom 50% would return 2, 4, 6, and 8.

### Data Filters

A data filter defines a condition such as **Analysis:Budget, Product:R1001 > 0**. Crossings that meet the criteria are displayed in the data-entry or read-only table, as shown in this example:
To view the filter criteria, hold the mouse pointer over the icon above the table.

You can temporarily remove a data filter. Click anywhere in the table and select Data Filter Remove. To restore the filter, select Data Filter Restore.

### Validating Data in a Form

#### About Data Validation

Data validation ensures that values in a data-entry table comply with certain constraints. For example, a company might want to make sure that employee bonuses do not exceed a specified percentage, or that new hiring does not exceed specified limits.

#### Run Validation Rules

Data validation rules are automatically run when you submit a form. A pop-up message box displays the results.

To view errors or warnings, you can also run the rules manually at any point when the form is open. To run data validation rules, follow these steps:

1. In the Data Validation section of the details pane, click Validate.

   If any crossings failed validation, a list of errors or warnings is displayed. (Only the first 100 items are returned.) There are three types of results:

   - **Error**: You must correct the error in order to submit the form successfully.
Error with comment: You must correct the error or add a public comment to the crossing in order to submit the form successfully.

Warning: You should examine the crossing and make necessary corrections. However, you can still submit the form without changes.

Note: Administrators can submit forms regardless of errors.

2 Click a rule.
   The cursor is positioned in the first crossing with that validation error or warning.

3 Click Next or Previous to view additional crossings with the same error or warning.
   If these crossings are associated with different slicer selections, the table view is changed accordingly. If the crossing is unreachable, a message is displayed.

4 To restore the original table display, click Clear validation results.

After you make any necessary changes, you can resubmit the form, or click Validate to run the data validation rules again.

What Is Checked
The validation process checks all navigable crossings within the rule’s scope, with these exceptions:

- crossings that are not readable. For example, the cell might be hidden or you might not have permission to view its contents.
- crossings that are protected from writing.
   An exception is a crossing that was protected in the form via the Protect Cell option. In that case, you could choose to unprotect the cell and correct the error. The validation process does check those crossings.

Note: A navigable crossing is one that you can display in the table. You might need to select a different slicer value or expand a row or column.
Supplemental Schedules

Overview

A form can include one or more supplemental schedules, which provide additional information to support data entry. Each supplemental schedule is associated with a data-entry table and can contain two types of measures:

- measures that correspond to members of the data-entry table.
- custom measures that were designed for use in a supplemental schedule. These measures might be numeric, or they might contain character strings, dates, or yes or no values.

You can recognize a supplemental schedule by its last two rows, which display column totals and averages in green cells. The corresponding crossings in the data-entry table are also displayed in green.

Enter Data in a Supplemental Schedule

Entering data into a supplemental schedule is like entering data into a data-entry table. You enter data in yellow (writable) cells of detail records for a specific member of the data-entry table. For example, the detail records might be associated with the organization dimension. When you open the form, only the detail records for the selected organization member are displayed.

At the bottom of the supplemental schedule are two rows that display totals and averages for the detail records. If a measure is also a member of the data-entry table, its totals are saved to the data-entry table. (The Detail averages row is provided only for reference.)

For top-down workflows, the supplemental schedule also contains a green Non-allocated row. This row displays the amount from the data-entry table that remains to be allocated in the supplemental schedule. (For the top-level member of the target hierarchy, this row is empty.)
Add a Detail Record

In addition to entering data into existing rows, you can add new detail records. For example, if the forms are being used for a budgeting process, each new detail record might represent a planned (but not yet hired) employee.

To add a row to a supplemental schedule, right-click a row heading and select **New Detail**. In the New Detail window, complete the following fields:

**Code, Name, and Description**

Enter a code, name, and description for the new detail record. The name appears in the row heading for the new record.

**Note:** If you enter a code that already exists, a subscript is added when you click **OK**. For example, “MyDetail” might become “MyDetail[2]”.

**Select the scope for this detail**

This prompt appears only if the form set designer did not already set the scope for all detail records. Select one of the following:

- **Make it available to other form sets.**
  
  The detail record is available to any forms that have the same detail dimension.

- **Limit its availability to this form set.**
  
  The detail record is available to any forms in this form set.

**Prompts for measures**

Depending on form set design, you might be prompted to enter or select initial values for some of the custom measures. These fields are optional.

Some custom measures are subject to validity checks when you click **OK**. For example, a numeric value or a date might need to fit within a specific range. If the value that you enter does not pass a validity check, an error message is displayed and you are given the opportunity to change the value.

**Note:** The **Reset group defaults** link resets all prompts to their default values.

The following functions are also available for working with detail records:
To modify the name and description of a detail record, right-click its row heading and select Edit Detail. (You cannot change the member code.)

To delete a detail record, right-click its row heading and select Delete Detail.

To copy values from one detail record, right-click its row heading and select Copy Detail Value. To paste those values into another record, right-click the row heading for the destination record and select Paste Detail Value.

Save the Supplemental Data

After you enter data into a supplemental schedule, click Save All Supplemental Data. The option affects all supplemental schedules in the form. In a bottom-up form, Save All Supplemental Data saves the totals for numeric measures to the related crossing in the source data-entry table. (Custom measures are not saved to the data-entry table.)

For a top-down form, no data is saved to the data-entry table. However, for both bottom-up and top-down forms, the supplemental schedule data is saved to the supplemental data provider’s database. In the SAS Financial Management Add-In for Microsoft Excel, this data is available when you select Contributing Data for a cell in the data-entry table.

Note: If the session times out, unsaved data in supplemental schedules might be lost. We recommend that you save supplemental data frequently.
Overview of the Reports Workspace

Use the Reports workspace to search for and display SAS Financial Management content. The following content types are supported in the Reports workspace:

- **Microsoft Excel spreadsheet**: a dynamic SAS Financial Management report. A dynamic report is a fully functional Excel binary file. It can be modified and its data can be refreshed.


- **PDF file**: a PDF document that can be opened in Adobe Acrobat.

Other content types, such as stored processes and SAS Web Report Studio reports, are available in the SAS Information Delivery Portal. For example, you can add a stored process to a Collection portlet or to a Stored Process Navigator portlet. SAS Web Report Studio reports are also available from the **File** menu of SAS Web Report Studio.
Open a Report

1. In the **SAS Folders** column, navigate to the folder that contains the file that you want to open.
   
   You can also click the Search button to search for a file.

2. Double-click a report to open it in the appropriate viewer.
   
   Alternatively, select the filename and click the Open Report button.

The report is opened from a new browser window or tab.

**TIP** If you don’t see a file listed, it might be an unsupported content type, or you might not have permission to view that file.

Search Reports

You can search reports by title, description, date, or location.

Follow these steps:

1. Click the Search button.

2. Enter some search text, or leave the search box empty to select all files that meet the other search criteria.
   
   The search text is not case sensitive.

3. Select **Include description and keywords** to search those attributes as well as the filename.

4. From the **Type** drop-down list, select the content type to search for:
- **(any type)**: any content type
- **(any applicable type)**: any content type that is supported in the Reports workspace
- **Microsoft Excel spreadsheet**: a dynamic SAS Financial Management report
- **Financial management report for Microsoft Excel**: a static SAS Financial Management report
- **PDF file**: a PDF document

Select **Choose types** if you want to select more than one content type to search for.

5. Select the location to search.

6. (Optional) Select a range of dates in which to search.

In this search window, the user is searching in the **Shared Data** folder for PDF reports, with “sales” in the title, description, or keywords, that were created in the past 7 days:

7. Click **Search**.

8. In the search results, use the View button to select more or less detail. You can also select a file and click the Delete button to remove it.

9. From the search results, select a file and click **OK**.
The file location is displayed, and the filename is highlighted.

**Note:** If that content type isn’t supported in the Reports workspace, clicking **OK** displays the correct location but not the file.

---

**Create a Report Folder**

To create a new folder, select the New Folder button 🗂️ and enter a folder name. You can create new folders under **My Folder** and in some other folders, depending on the permissions that administrators have assigned.

To delete content, select a file or folder and click the Delete button 🗑️.
Process Management

Introduction to Process Management ................................................. 58
  Overview .................................................................................. 58
  Your Role in Process Management ............................................... 59
  Receive an Alert Notification ....................................................... 60

View an Active Process .................................................................. 61

Working with Tasks .......................................................................... 62
  View Tasks .................................................................................. 62
  Task Status .................................................................................. 64
  Run a Task .................................................................................. 65
  If a Task Fails .............................................................................. 66
  Enable or Disable a Task ............................................................... 67
  Reschedule a Task ....................................................................... 67
  Add a Comment ........................................................................... 68
  View Task History ....................................................................... 68

View Process Status on a Tablet ....................................................... 69
  Overview .................................................................................. 69
  View Process Details ................................................................... 70
  View Task Details ....................................................................... 72
  Run or Skip a Task ..................................................................... 73
Introduction to Process Management

Overview

Using Process Management, you can define, view, and manage the business-specific processes from a central location. You define a process in a process definition, which is a template that contains tasks that describe your company-specific process, the order in which the tasks execute, and any default properties for the tasks. A process is a running instance of a process. It is started from a process definition and contains data specific to that instance only. Examples of a process include month-end close, a rolling forecast, and budgeting.

A process manager defines the process and its tasks. When the process manager starts the process, it becomes active. The first task in the process is the active task. When that task completes, the next task becomes active, and so on.

The next figure shows an active process:

Figure 4.1 Active Process Display
1. **File** menu, including **Recent work** and **Preferences**.
2. **Help** menu, including How-to topics and important links.
3. Name of the process.
4. **Tasks** tab, for working with process tasks.
5. **Properties** tab, for viewing properties that apply to the entire process.
6. **Notifications** tab, for viewing notifications that apply to the entire process.
7. Category pane. If you are a process viewer, two categories are available: **Active Processes** and **Completed Processes**.
8. Enable task ✅ and Disable task ⬅️ buttons.
9. Refresh button 🔄.
10. At the bottom of the page is the tile pane, with a minimized view of the processes that you have open. Click a process to display it.
    
    To display more than one process at a time, click **View** and make a selection.

11. The Maximize view button ⬠ hides header information, to make more room for the process or task display.

12. **Close** closes the process.

13. **History** section, for viewing history for the selected task. Click a column heading to sort the list by that column.

14. **Comments** section, for entering or viewing comments for the selected task.

15. **Log Off** or **Portal**.

    If you reached SAS Financial Management from the SAS Information Delivery Portal, the **Portal** link returns you to the portal, where you can log off.

---

**Your Role in Process Management**

Your role in Process Management depends on your capabilities and task ownership:
If you are a process viewer, you can view active or completed processes on the web or in a tablet.

If you are assigned as an owner of a task, you can run or skip the task, reschedule the task, and disable or enable the task, depending on task status.

Additional capabilities are required for most tasks. If you are a task owner but can't run the task, check with a process manager.

Note: If you are a process manager, see “Starting a Process” in the SAS Financial Management: Process Administrator's Guide for information about your role in an active process.

Receive an Alert Notification

When a process or a task changes state, you might receive an alert notification. The alert might be informational only, or a task might need your attention. The links in the alert take you to SAS Financial Management on your computer or in a tablet.

Possible notifications are as follows:

Table 4.1  Alert Notifications

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process event: Started</td>
<td>The specified process is now active.</td>
</tr>
<tr>
<td>Process event: Completed</td>
<td>The final task in the specified process completed, and the process was automatically moved to the <strong>Completed Processes</strong> category.</td>
</tr>
<tr>
<td>Process event: Canceled</td>
<td>A process manager canceled the process. It was moved to the <strong>Completed Processes</strong> category.</td>
</tr>
<tr>
<td>Task event: Started</td>
<td>This notification is sent when a task becomes active.</td>
</tr>
<tr>
<td></td>
<td>If the task is automatic, it has started running.</td>
</tr>
<tr>
<td></td>
<td>If the task is manual or prompted, it is waiting for user intervention.</td>
</tr>
<tr>
<td></td>
<td>See “Run a Task” on page 65.</td>
</tr>
</tbody>
</table>
### View an Active Process

A process is active when it has started, but at least one of its tasks has not finished. When the last task finishes, the process moves to the **Completed Processes** category.

To view an active process:

1. Select one of the following options:
   - In a web browser, log on to SAS Financial Management and select the Processes workspace.
   - In a web browser, log on to the SAS Information Delivery Portal. In the Alerts portlet, click an alert notification link.
   - From an e-mail message, click a link to the Processes workspace.

2. Select the **Processes** tab.

3. Select the **Active Processes** category.
The list of active processes is displayed, with the following information: **Name**, **Description**, **Process State**, and **Process Date**.

**Process State** can be one of the following:

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Started</td>
<td>The process has started. One of its tasks is executing or waiting for user intervention.</td>
</tr>
<tr>
<td>Failed</td>
<td>One of the process’s tasks has failed. View the task list for details. You still might be able to fix the problem and rerun the task.</td>
</tr>
</tbody>
</table>

**Process Date** is the date that was assigned by the process manager upon starting the process. Its meaning depends on how the process was designed. For example, it might represent the date on which the process begins or the date on which the process ends.

**TIP** You can also follow a process in an application that runs in a tablet. With the required capabilities, you can run or skip tasks. See “View Process Status on a Tablet” on page 69.

---

**Working with Tasks**

**View Tasks**

In an active process, only one task is active at a time. The task might be running, or it might be waiting for user intervention. (The exception is a task group, in which multiple subtasks can run at the same time.)

To view the tasks in a process, select the process and click **Open**.
The display contains the following columns:

**Table 4.3  Columns That Are Displayed for Tasks in an Active Process**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name of the task.</td>
</tr>
<tr>
<td><strong>Actions</strong></td>
<td>Available actions for the task (in a drop-down list), such as <strong>Run</strong> or <strong>Skip</strong>. For a manual task, the only action is <strong>Complete</strong>.</td>
</tr>
</tbody>
</table>
| **Task#**       | The task’s place in the list. Tasks are executed in sequence.  
**Note:** Subtasks do not have a task number. |
| **Owners**      | The users who are assigned as task owners. One user is the primary owner. |
| **Task Type**   | What the task does (for example, publish a form set, lock a model, or load data).  
For a description of task types, see the online Help. |
| **Schedule**    | When the task is scheduled to run, displayed in your time zone.  
See “Reschedule a Task” on page 67. |
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Due Date</td>
<td>When the task is due. A task becomes overdue the day after the due date. If you are in a different time zone from the one in which the process was started, the Due Date column displays both the date and time, in your time zone. Imagine that a process is started in the Eastern time zone. One of its tasks has a due date of June 15. That task becomes overdue at midnight (Eastern time) on June 16. If you are in the Eastern time zone, the due date is displayed as June 15. If you are in the Central time zone, the due date is displayed in Central time, as June 15 11:00 PM.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the task. See “Task Status” on page 64.</td>
</tr>
<tr>
<td>Active Count</td>
<td>The number of times the task has become active. As a task becomes active, its active count increases by one. For example, you run tasks A, B, C, and D. Each task has an active count of one. You run tasks B and C a second time. Tasks B and C now have active counts of two. Note: Skipping a task, or repeating a failed task, does not alter the count.</td>
</tr>
<tr>
<td>Date Completed</td>
<td>The date on which the task was completed.</td>
</tr>
<tr>
<td>Completed By</td>
<td>The user who completed the task action, such as running the task. For an automatic task, this field contains the task’s primary owner.</td>
</tr>
</tbody>
</table>

**TIP** To view more columns, click the Expand button to expand the task view and hide the Comments and History sections.

**Task Status**

In an active process, task status can be one of the following:
### Task Status in an Active Process

<table>
<thead>
<tr>
<th>Task Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active (running)</td>
<td>The task is currently being executed.</td>
</tr>
<tr>
<td>Active (waiting)</td>
<td>The task requires some type of user intervention, such as running, skipping, or rescheduling the task. If this is a manual task, it is waiting for you to mark it complete.</td>
</tr>
<tr>
<td>Active (failed)</td>
<td>The task has failed for some reason. You can run it again or choose to skip this task. See “If a Task Fails” on page 66.</td>
</tr>
<tr>
<td>[no status]</td>
<td>The task has not yet become active.</td>
</tr>
<tr>
<td>Disabled</td>
<td>The task is disabled and is unavailable for execution. If the process hasn’t yet reached this task, you can re-enable it.</td>
</tr>
<tr>
<td>Skipped</td>
<td>A task owner or process manager has chosen to skip this task.</td>
</tr>
<tr>
<td>Complete</td>
<td>The task has been successfully completed.</td>
</tr>
</tbody>
</table>

A task group is a parent task with a set of subtasks. The task group status depends on the status of its subtasks. For example, if one of the subtasks has a status of Active (failed), then the task group status is also Active (failed). If no subtask has failed, but a subtask has a status of Active (waiting), then the task group status is also Active (waiting). A task group is not marked Complete unless all its subtasks have been run, skipped, or disabled.

### Run a Task

#### Automatic Tasks

Tasks can be categorized as automatic, prompted, or manual. An automatic task has all the necessary information to run. By default, it is run as soon as it becomes active—that is, as soon as the preceding task is completed.

An automatic task can also be scheduled to run at a specific time of day. If you are a task owner, you have the option of rescheduling the task, depending on task status. See “Reschedule a Task” on page 67.
Prompted Tasks
A prompted task, like an automatic task, has all the necessary information to run. However, you must explicitly run it.

- To run a task, select Run from the Actions column.
- To skip the task, select Skip.

You can reschedule a prompted task so that it runs automatically at a specific time.

Manual Tasks
A manual task requires you to perform one or more actions outside process management. For example, you might need to check a report, run an external data management task, or simply confirm that an action has been performed.

Manual tasks are not associated with a schedule. When the manual task has been performed, select Complete.

TIP A manual task cannot be skipped. If the task is not performed for some reason, mark it complete and add a comment in the Comments section.

If a Task Fails
If a task fails, its status is Active (failed). The reason for the failure is shown in a popup message or on the General tab of the task properties.

You have the following options:

- You can run the task again.
  If necessary, you can modify the task schedule.
- You can skip the task.

If you do not have the required capability to run the task, ask a process manager for help.
Enable or Disable a Task

If a task is not yet active, and you are a task owner or a process manager, you can enable or disable the task.

- To disable one or more tasks, select the tasks and click the Disable button.
- To enable tasks that were disabled, select the tasks and click the Enable button.

Reschedule a Task

Depending on task status, a task owner or a process manager can reschedule a task.

On the Schedule tab, the following selections are available:

- **Run when active**: When the task becomes active, it is automatically run.
- **Prompt before running**: You are prompted to run or skip the task.
- **Run at time**: The task is automatically executed at a specific time of day.

For example, you might want a task to run only in the middle of the night. The time can be relative to when the task becomes active, or relative to the task due date. For example, this task is set to run at 1 a.m. after the task becomes active:

If the task became active at 8 a.m. on Thursday, it would run at 1 a.m. on Friday.

**Note**: All times are displayed in your time zone.
Add a Comment

In the Comments section, you can add or view comments for a task.

1 Select a task.

2 In the Comments section, enter a topic name. On the line beneath it, enter the comment.

   Note: The first line in the Comments section is a search box. To filter comments, type a search string and press Enter.

3 (Optional) To attach a document to the comment, click the Attach a file button.

4 Click Post.

Comments are stored with the process and are available in both the Active Processes and Completed Processes categories.

View Task History

In an active or completed process, the History section displays details of each task.

Select a task to view its history. You can sort the display by any of its columns:
### Table 4.5  Columns in History Display

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Actions that were taken for this task, such as Complete, Skip, or Disable.</td>
</tr>
<tr>
<td>User</td>
<td>The user who performed the action. For the Complete action of an automatic task, the User column lists the task’s primary owner.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>The date and time for the action, displayed in your time zone.</td>
</tr>
</tbody>
</table>

---

**View Process Status on a Tablet**

**Overview**

On a tablet, you can view the status of a process and its tasks. You can view task details and run or skip a task that is waiting for user intervention.

The main display is a list of processes.
By default, all processes are displayed. To display only active or completed processes, click the Active or Complete buttons at the top of the screen.

To filter the display, enter a keyword in the filter box at the top.

The display lists the process name and the number of tasks that have completed. A flag indicates that the process is past its due date.

**View Process Details**

Select a process to drill down into its details. The list of tasks is displayed.
The display lists each task and its due date. Task status is shown by the symbols to the left of the task name:

**Table 4.6  Task Status Symbols**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Task Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎉</td>
<td><strong>Active</strong></td>
<td>The task is active. It might be running or waiting user intervention, such as running or skipping the task.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If this is a manual task, it is waiting for you to mark it complete.</td>
</tr>
<tr>
<td>✗</td>
<td><strong>Active (failed)</strong></td>
<td>The task has failed for some reason. You can run it again or skip this task. See “If a Task Fails” on page 66.</td>
</tr>
<tr>
<td>⏳️</td>
<td><strong>Inactive (no status)</strong></td>
<td>The task has not yet become active.</td>
</tr>
<tr>
<td>❌</td>
<td><strong>Disabled</strong></td>
<td>The task has been disabled.</td>
</tr>
</tbody>
</table>
A task can have the following flags:

- 🔴 overdue task
- 📣 task with comment

**View Task Details**

Select a task to drill down into its details.

The display lists the task status, the current process, the task name and description, the task owners, and the task due date. Any comments are displayed, with the most recent comments first.

If the task failed, the display indicates the reason for the error, if possible.

For more information about task owners and due dates, see “View Tasks” on page 62.
Run or Skip a Task

If a task is active and waiting for user intervention, click the Run or Skip button to run the task or skip to the next task.

**Note:** You can’t reschedule, enable, or disable a task from a tablet.
Log On to SAS Financial Management

You can log on to SAS Financial Management either of the following ways:

- Respond to an alert notification that a form is ready for editing or review. See “Receive an Alert Notification” on page 8.

- Log on to the SAS Information Delivery Portal and open SAS Financial Management.

Your portal pages might already contain a link to SAS Financial Management. If you need to add a link, follow these steps:
1 In a Collection portlet, click the Edit Content button.

2 In the Edit Portlet Content window, click Add Items.

3 In the Add Items to Portlet window, click the Search tab.

4 In the Content Types list, select Application.

5 Enter Forms as a keyword and click Search.

6 In the search results, select the SAS Financial Management application and add it to your portal page.

For more information about creating a Collection portlet and adding content, see the online Help for the SAS Information Delivery Portal.

---

Access SAS Financial Management Content from the Portal

From the SAS Information Delivery Portal, you can access the following SAS Financial Management content:

- **a dashboard that displays form status.** See “The Form Status Dashboard Portlet” on page 77.

- **alerts of forms that are ready for editing or review.** See “Display Alerts in the SAS Information Delivery Portal” on page 79.

- **SAS reports.** SAS reports are generated by the Publish wizard in the SAS Financial Management Add-In for Microsoft Excel. These static reports can be opened in SAS Web Report Studio. They display current data but cannot be modified.

In the portal, SAS reports can be added to a Collection portlet. Clicking a report opens it in SAS Web Report Studio.

For more information about creating and using SAS reports and information maps, see the online Help for the SAS Financial Management Add-In for Microsoft Excel and the online Help for SAS Web Report Studio.
Information maps. Information maps are generated by the Information Map wizard in the SAS Financial Management Add-In for Microsoft Excel. Users can open an information map as a dynamic report in SAS Web Report Studio, meaning a report that contains the current values in the database for the dimension members and crossings defined in the information map.

In the portal, information maps can be added to a Collection portlet. Clicking an information map opens it in SAS Web Report Studio.

Note: Information maps that are created in the SAS Financial Management Add-In for Microsoft Excel cannot be opened in SAS Information Map Studio.

Standard reports. For more information about the standard reports, see “Run SAS Financial Management Reports” on page 80.

You must have the necessary capabilities and security permissions to perform these tasks and view the data.

The Form Status Dashboard Portlet

Overview

In the SAS Information Delivery Portal, you can view a SAS BI Dashboard portlet with a graphical display of form status. By default, the portlet contains the following indicators:

- number of forms that are in progress, completed, or not yet started
- number of forms that are overdue or approaching deadline

The display is filtered to contain information only about forms that are available to you.

Working with the Portlet

- To modify the display, click the Edit Content button in the portlet’s toolbar.
- To view the indicators in the SAS BI Dashboard viewer instead of in a portlet, click in the BI Dashboard toolbar.
Click an indicator to open the Forms workspace of SAS Financial Management, with that filter applied. (Might trigger an additional logon.) For example, if you click the Overdue section of the Approaching deadline indicator, the display is filtered to show only forms that are overdue.


**Adding the Form Status Portlet to Your Portal Page**

Your portal pages might already contain a SAS BI Dashboard portlet with the form status indicators. If not, follow these steps:

1. In the portal, select Customize ➤ Edit Page ➤ Edit Page Content.

2. On the Edit Page Content page, select Add Portlets.

3. From the drop-down list of portlets, select SAS BI Dashboard Portlet.

4. Add the portlet to the portal page.

   For more information about portlets, see the online Help for the portal.

5. Click the portlet’s Edit Content button 📝.

6. On the Edit Portlet page, select the form status dashboard, which is located in the Products ➤ SAS Financial Management ➤ Dashboards ➤ Form status folder.
By default, the portlet refreshes automatically every 30 seconds. To disable this functionality, clear the **Auto refresh interval** check box. (You can manually refresh the portlet.) Alternatively, you can specify a larger interval.

Click **OK**.

---

**Display Alerts in the SAS Information Delivery Portal**

An alert is a notification of an event that you might need to respond to. For example, you might receive an alert that a form is available for editing or review, or you might receive an alert that your forecasting job has completed.

In the Preferences window of the portal, you can select your preferred notification methods. (You can select more than one method.) If you select **My alerts portlet**, alerts are displayed in an Alerts portlet that you can add to one of your portal pages. Follow these steps:

1. In the portal, select **Customize > Edit Page > Edit Page Content**.
2. On the Edit Page Content page, select **Add Portlets**.
3. From the drop-down list of portlets, select **Shared Alerts Portlet**.
4. Add the portlet to the portal page.
5. Edit the portlet if you want to display the alert type or select the alert types to be displayed.

**TIP** The Shared To-Do Alerts portlet is also available. It displays only workflow alerts.

To delete an alert, select its check box and click **Remove**.

For more information about portlets, see the online Help for the portal.
Run SAS Financial Management Reports

The following stored processes are available in the portal to users who have access to the `/Products/SAS Financial Management/5.4 Standard Reports` folder. In these reports, credits are shown as negative numbers and debits are shown as positive numbers.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit</td>
<td>Lists actions that have been completed. You can limit an Audit report to an object type (such as cycle or formset), a user, or a range of dates.</td>
</tr>
<tr>
<td>Data Entry</td>
<td>Lists data records that were entered through forms using a specified model. You can limit a Data Entry report to a time period, an organization, an analysis member, or a form set.</td>
</tr>
<tr>
<td>Eliminations</td>
<td>Lists, for a specified model, data records for all accounts that have the Intercompany attribute but that are not specified in any intercompany balancing rule or net intercompany balancing rule. There should not be any such accounts, so this report should not list any data records. If the report does list data records, then you need to edit the rules that look for imbalances in intercompany accounts, or add more such rules. You can limit an Eliminations report to a time period, an organization, or an analysis member.</td>
</tr>
<tr>
<td>ETL Facts</td>
<td>Lists data records that have been loaded from SAS Data Integration Studio to a specified time period and analysis member within a specified cycle. You can further limit an ETL Facts report to a specified organization.</td>
</tr>
<tr>
<td>Facts</td>
<td>Lists data records that are associated with a specified model. You can limit a Facts report to a time period or an analysis member, and in several other ways.</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ICAccounts</td>
<td>Lists, for a specified model, accounts that have the Intercompany attribute but that are not specified in any intercompany balancing rule or net intercompany balancing rule. You can limit an ICAccounts report to accounts that belong to a particular account type or accounts that have a particular balance type.</td>
</tr>
<tr>
<td>Intercompany</td>
<td>Lists, for a specified model, data records in which the account member has the Intercompany attribute and the trader member is either EXT or identical to the organization member. No records should satisfy this condition. You can limit an Intercompany report to a time period, an organization, or an analysis member.</td>
</tr>
<tr>
<td>Manual Adjustments</td>
<td>Lists all the currently posted manual adjustments for a specified model. You can limit a Manual Adjustments report to a time period, an organization, or an analysis member. You can also limit the report to a range of adjustment amounts.</td>
</tr>
</tbody>
</table>
## Report Description

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule</td>
<td>Lists all the adjustments that are generated by a specified adjustment rule within a specified model. You can limit a Rule report to a time period or an analysis member.</td>
</tr>
<tr>
<td>Rules Facts</td>
<td>Lists all the adjustments that are generated by all the adjustment rules that are part of a specified model. You can limit a Rules Facts report to a time period, an organization, or an analysis member. You can also limit the report to a range of adjustment amounts.</td>
</tr>
<tr>
<td>Trial Balance</td>
<td>Lists data records that are associated with a specified model and that were loaded from the SAS Financial Management staging area. You can limit a Trial Balance report to a time period, an organization, or an analysis member.</td>
</tr>
</tbody>
</table>

In the portal, add one or more stored processes to a Collection portlet. Click a stored process to execute it. For more options, see the online Help for the SAS Information Delivery Portal.

**Note:** The ETL Job Status and Import Users and Groups stored processes are for use only by administrators. The Form Status stored process is used only by the Form Status dashboard and cannot be run from a Collection portlet. Stored processes in the Custom Analytics folder are for use in data entry (via the Excel add-in) and cannot be run from a Collection portlet.
Part 2

The SAS Financial Management Add-In for Microsoft Excel

Chapter 6
Getting Started with the Excel Add-In ........................................ 85

Chapter 7
Viewing Financial Reports ......................................................... 87

Chapter 8
Working with Data-Entry Forms .............................................. 89

Chapter 9
Working with Tables ............................................................... 107
Chapter 10
Data Filters, Ranking, and Sorting ........................................ 125

Chapter 11
Cell Protection ..................................................................... 137

Chapter 12
Hold Rules ........................................................................ 139

Chapter 13
Supplemental Schedules ...................................................... 147

Chapter 14
Forecasting ......................................................................... 151
Getting Started with the Excel Add-In

Overview of the SAS Financial Management Add-In for Microsoft Excel

Accessing the Excel Add-In

Overview of the SAS Financial Management Add-In for Microsoft Excel

The SAS Financial Management Add-In for Microsoft Excel connects your desktop copy of Microsoft Excel to the SAS Financial Management database. Through this connection, data can flow from the SAS Financial Management database to a Microsoft Excel worksheet and from a Microsoft Excel worksheet to the SAS Financial Management database.

Accessing the Excel Add-In

The following describes how to access the Excel Add-in through typical tasks:

- **Design a financial report.** Open Microsoft Excel on your desktop and then use the SAS Financial Management Log On option.
Note: If you have another workbook open and are logged on to SAS Financial Management, you are not asked to supply your credentials again. If you want to connect to a different server, you must open another instance of Microsoft Excel.

- **View a financial report.** From a web data entry browser, log on to SAS Financial Management and select **Reports**. From the navigation tree, select an Excel report. No additional logon is necessary.

- **Design a data-entry form template.** In the **Forms** workspace of SAS Financial Management Studio, select a form set and select **Show Template**. The form template opens in Microsoft Excel. No additional logon is necessary.

- **Enter data in a form.** From a web data entry browser, log on to SAS Financial Management and select **Forms**. From the list of available forms, select a form and click the Open in Excel button 📊. The form opens in Microsoft Excel. No additional logon is necessary.
About Financial Reports

Overview

A financial report displays numeric values that are either stored in the SAS Financial Management database or computed from values that are stored in the SAS Financial Management database. It can contain read-only tables or cell data access (CDA) tables, or both.

Read-Only Tables

Read-only tables are multi-dimensional tables that provide interactive capabilities such as expanding and collapsing hierarchies, drill-down, filtering, pivoting, and commenting.

A dynamic report that is based on a read-only table displays current values from the SAS Financial Management database. A static report displays values that existed when the report was published.
CDA Tables

Cell data access (CDA) tables are collections of cells that use CDA functions (such as CDAGet) to retrieve values from the SAS Financial Management database for the specified model. Reports can also contain single cells that use CDA functions to access database values.

A report that is based on a CDA table displays current values from the SAS Financial Management database. In a read-only table, users have options such as dynamic member selection and property selection rules. In contrast, the references in a CDA table are static.

Viewing a Financial Report

If you open a report from the web data entry, you are already logged on to SAS Financial Management and can view the report (subject to security provisions). If you open a dynamic report from a local directory, you must first log on.

If the report is dynamic and includes a read-only table, you can change your view of that table in a variety of ways, including the following:

- Select another member from a slicer dimension to display another slice of numeric values. Slicer dimensions are listed above the table itself. A worksheet with multiple tables has the option of sharing common dimensions that are placed on the slicers.
- Click an underlined row heading or column heading to expand or collapse the portion of the hierarchy that is subordinate to it.
- Select a table cell and then select an option such as Filter Member Combination, Format Members, or Pivot to affect your view of the table.
Working with Data-Entry Forms

About Data Entry ................................................................. 90

Bottom-Up and Top-Down Form Sets .................................... 91
  Bottom-Up Form Sets ...................................................... 91
  Top-Down Form Sets ..................................................... 91

Entering Data ........................................................................ 92

Refreshing Values .................................................................. 93

Virtual Children ................................................................... 94

Entering Data into Parent Cells ............................................ 94

Data Entry with Hold Rules .................................................. 95
  Overview ........................................................................ 95
  Example: Hold on Parent Member ...................................... 96

Reviewing Data as Part of a Bottom-Up Workflow ................ 97

Entering Data Offline ............................................................ 97

Adjusting Values for a Range of Cells ................................. 98
  Overview of the Adjust Values Window ............................... 98
  Adjust Values by Multiplier .............................................. 99
  Adjust Values by a Fixed Amount ...................................... 99
  Adjust Values by a Proportional Amount ............................ 99

Spreading Values across Cells ............................................. 100
  Overview of the Spread Window ....................................... 100
About Data Entry

You enter data through forms that have been designed in SAS Financial Management Studio and published from there to the web data entry. The forms that you are responsible for are available to you when you log on to the SAS Financial Management web data entry application.

Each form typically contain’s one or more data-entry tables. Some forms also contain supplemental schedules, read-only tables, or CDA tables.

A form set is a collection of forms that can include data entry tables and are subject to a defined workflow process. The workflow for the form set is based on the selected target hierarchy and associated members within that hierarchy. Each form is associated with a member of the target hierarchy, although only certain members of the hierarchy might be selected to have forms.

To open a form, you log on to the Forms workspace of the SAS Financial Management web data entry application. Based on form set properties, you can open the form on the web data entry or in Microsoft Excel. From Microsoft Excel, you can also check out a form for offline editing, with some restrictions. For example, the form cannot include a supplemental schedule and cannot enable writing to parent members.

When you complete your edit or review, you use the Forms workspace to send the form to the next state in the workflow.

Note: You must have an appropriate role to enter or review data in a data-entry form.
See Also

- “Entering Data into a Supplemental Schedule” on page 147
- “Entering Data Offline” on page 97

Bottom-Up and Top-Down Form Sets

**Bottom-Up Form Sets**

The route that a form takes is determined by the form set’s workflow. In a bottom-up form set, data is entered at the lowest hierarchical level that is defined in the form set. When the data entry for a form is complete, the author submits the form set to the reviewer for either approval or rejection. For each form level, data is entered, submitted to the next level up for approval, and aggregated if approved. If a form is rejected, it might be returned to the previous author for additional editing.

**Top-Down Form Sets**

In a top-down form set, data-entry proceeds down the target hierarchy. If you are the author for the top-level form, you enter all the amounts that will cascade down the target hierarchy for the workflow. To do this, you manually enter data into crossings that include the virtual child of the top member in the target hierarchy. Then you allocate those amounts to one or more lower levels of the target hierarchy. When the data entry is complete, you use the **Push** action to make the subordinate forms accessible to the next set of form authors.

If you are the form author at the next level in the target hierarchy, you allocate the data that you received and push it down another level. Use the Allocate wizard to allocate amounts to one or more lower levels of the target hierarchy. Alternatively, you can manually enter an amount that is less than or equal to the allocated amount. Any difference is returned to the parent’s virtual child member. You can also spread allocated amounts to siblings of the allocated crossing’s dimension members. The total amount allocated must be the same or less than the original amount allocated.
At the lowest level of the target hierarchy, you cannot allocate, but you can use the **Spread** option to redistribute those amounts.

**Note:** If you are the author of a form that has descendants, you can allocate amounts to all lower levels and use the **Push to All** action to bypass any further allocations.

---

**Entering Data**

You enter data in the yellow (writable) cells. These cells belong to the organization member or members that you are responsible for. Another participant in the same workflow might see the same data-entry table with a different set of cells shown in yellow.

**Note:** You can use Excel’s **Copy** and **Paste** functionality to copy one or more values to a writable location in the form. If the Excel clipboard is open, you can paste the same selection from the clipboard multiple times.

For information about a crossing, right-click the cell and select **Tools ➤ Cell Information**.

Data cells are also color-coded. The default colors are as follows:

<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Yellow Cell" /></td>
<td>A yellow cell is writable. You can enter data into it, and it can be the target of a spread, adjust values, or paste operation.</td>
</tr>
<tr>
<td><img src="image" alt="Red Cell" /></td>
<td>A red cell is not readable or writable. You might not be authorized to view its contents, or its contents might be invalid. If no cells in the current rows and columns are readable, or if a data filter returns no rows, the data-entry table contains a single red cell.</td>
</tr>
</tbody>
</table>
### Color | Meaning
---|---
This cell is read-only. It might contain a parent member, a calculated member, or a member that is read-only because of data security, cell protection, or another option. You can view the cell’s contents but you cannot enter data into it directly. However, it can be subject to indirect changes such as allocations or consolidations.

**Note:** In some form sets, parent cells are writable. In that case, they are displayed in yellow. See “Entering Data into Parent Cells” on page 94.

An empty gray or white cell is not readable or writable. Its value might be hidden by a visibility rule or by a filter member combination.

The value in this cell has been placed on hold. You can enter data into it directly, but it is protected from indirect changes.

This cell is protected, and it is also covered by hold rules. You cannot enter data into it directly, and it is also protected from indirect changes such as allocations and consolidations.

A green cell receives data from a supplemental schedule. (See “Entering Data into a Supplemental Schedule” on page 147.)

### See Also

“Entering Data Offline” on page 97

---

**Refreshing Values**

By default, data is stored in the database as you enter it. If the data entered in a form affects additional cells, those cells are automatically updated.

If **Intelligent writeback** is enabled, writeback occurs after a short period without user input, or when a refresh action takes place. Until then, newly entered data is displayed in bold face type.
To explicitly refresh the display, click **Refresh** (to refresh the current worksheet) or **Refresh All** (to refresh all worksheets in the workbook). Some other actions, such as changing a slicer member, also trigger a refresh.

The refresh operation saves the data, formats recently entered numeric values correctly, and recomputes values that depend on the new data. For example, the data that you enter into a cell might trigger a calculation that affects other cells.

**Note:** **Intelligent writeback** is always disabled for top-down forms.

When you complete your data entry, close the form. If you have pending data records, you are asked if you want to save or discard them.

Unless you are entering data offline, there is no need to save the file on your local hard drive. However, if you made changes to the form (for example, if you removed an analysis member from the data-entry table, sorted the table, or made formatting changes), and you want to save those changes, select **Save Form Design** before closing the form.

---

### Virtual Children

A virtual child (VC member) is automatically assigned to any member that has child members that roll up to it. In a data-entry table, the virtual child is a writable member whose values contribute to the parent member.

If the VC member is displayed in the table, you can use it to enter data for the parent without associating that data with a (real) child member. Virtual children are available in all hierarchical dimensions except the Time and Source dimensions.

---

### Entering Data into Parent Cells

**Note:** These options apply only to forms in a bottom-up workflow.

In most cases, a parent cell is not writable, because its value is derived from the values of its subordinate cells. If writing to parent members is enabled, the cell is displayed in
yellow. When you enter data into a writable parent cell, the value is distributed in one of these ways:

- **Allow data to be entered for parent members other than time**
  The change in value is added to the parent’s virtual child (VC) member.

- **Allocate from Parent members other than Time using predefined weights**
  (automatic allocation)
  A value that is entered in a parent cell is automatically distributed among eligible leaf members, based on weights that are defined in the Allocation Weights window.

- **Allow data to be entered for Time Parent members**
  Users can enter a value in a non-leaf member of the Time dimension. The distribution is defined in the table properties.

For more information, see the online Help for the table properties.

**Note:** These options can be enabled or disabled only by an administrator of the form template.

---

**Data Entry with Hold Rules**

**Overview**

**Note:** This feature applies only to bottom-up form sets.

If a cell in a data-entry table is being held, it is protected from indirect changes such as allocations and consolidations. For example:

- If the hold is on a leaf cell, and you write to its parent cell, the leaf cell gets no allocation from the parent.

- If the hold is on a parent cell, and you write to one of the descendant (leaf) cells, the change in value is subtracted from the other descendant cells. The parent value stays the same.
You can enter a value directly into a held cell. It is also available as a target of actions such as paste, Spread, and Adjust Values.

**Example: Hold on Parent Member**

As a simple example, imagine a data-entry table that contains a parent member Administrative Expense and several child members. There is a hold on the parent member, as explained by the Cell Information option, and the cell is displayed in light purple.

![Data-entry table](image)

You increase the value of Water from 4 to 8. Because of the hold, the parent member (Administrative Expense) cannot change in value. To redistribute the change to Water, the values of the sibling members to Water are decreased.

![Data-entry table after change](image)

The changes to the other members are proportional to their previous values. If a member has a value of 0, it does not change at all.

**Note:** If automatic allocation is enabled, changes are based on allocation weights when you write to a parent cell.

For more information, see “Designing Holds for Data-Entry Forms” on page 139.
Reviewing Data as Part of a Bottom-Up Workflow

Reviewing the data in a form is basically the same task as viewing a financial report.

See Also

“Viewing a Financial Report” on page 88

Entering Data Offline

Typically, you enter data into a form while the SAS Financial Management Add-In for Microsoft Excel is connected to the SAS Financial Management server.

You can also enter data into a form while it is offline. To make this possible, check out the form and save it as a local Excel file. Each time you edit the form, save it in the local file. Cells whose values depend on the data that you enter are not updated as you work. Eventually, you check the form in again, reconnecting it to the server. At that point, all the data that you entered offline is saved in the SAS Financial Management database, and cells whose values depend on the data that you entered offline are automatically updated.

Note: This option is not available in certain cases: for example, forms with a supplemental schedule, forms in which writing to parent members is enabled, or forms to which ranking, sorting, or data filtering has been applied.

To check out a form for offline data-entry:

1 Open the form in Microsoft Excel.

2 In Excel, select Check Out Form.
The Check Out Form window appears.

3 In the Check Out Form window, click **Yes**.

   The Save As window appears.

4 In the Save As window, specify the location where you want to save the file, and click **Save**.

To check in an offline form:

1 Open your local copy of the file.

2 Select **Check In Form**.

   The SAS Log On window appears.

3 After you log on, the Check In Form window appears.

4 In the Check In Form window, click **Yes**.

   The SAS Financial Management Add-In for Microsoft Excel connects to the SAS Financial Management server. All the data in the local copy of the form is written to the SAS Financial Management database.

---

**Adjusting Values for a Range of Cells**

**Overview of the Adjust Values Window**

Use the Adjust Values window to change the values in selected cells:

1 Select a range of cells.

   **Note:** The range that you select cannot contain a read-only cell, a protected cell, or a parent cell.

2 Right-click and select **Adjust Values**.
3 In the Adjust Values window, select the type of adjustment (multiplier, fixed value, or proportional value) and enter an adjustment amount.

The **Total selected value** field displays the sum of the values in the selected cells. The **Total adjusted value** field gives a preview of the sum of those values after adjustment.

### Adjust Values by Multiplier

To multiply the value in each selected cell by a specified number:

1 In the Adjust Values window, select **By multiplier**.

2 Enter the multiplier in the adjacent field. It can be positive or negative.

   The value of each cell is multiplied by the value that you enter.

### Adjust Values by a Fixed Amount

To change the value in each selected cell by a fixed amount:

1 In the Adjust Values window, select **By value**.

2 Enter the amount in the adjacent field.

   The amount can be positive or negative. This value is added to each selected cell.

### Adjust Values by a Proportional Amount

To allocate an amount to the selected cells in proportion to their original values:

1 In the Adjust Values window, select **By value**.

2 Enter the total amount to allocate in the adjacent field.

3 Select the **Modify each cell proportionally** check box.

Here are some examples of proportional adjustment, each example affecting two cells:
<table>
<thead>
<tr>
<th>Original Values</th>
<th>Adjustment</th>
<th>Resulting Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 and 10</td>
<td>3</td>
<td>6 and 12</td>
</tr>
<tr>
<td>5 and 10</td>
<td>-3</td>
<td>4 and 8</td>
</tr>
<tr>
<td>(5) and (10)</td>
<td>3</td>
<td>(4) and (8)</td>
</tr>
<tr>
<td>(5) and (10)</td>
<td>-3</td>
<td>(6) and (12)</td>
</tr>
</tbody>
</table>

**Note:** Proportional adjustment is not possible if the selected range of cells contains both positive and negative values. In these cases, the Modify each cell proportionally check box is not available.

---

**Spreading Values across Cells**

**Overview of the Spread Window**

Use the Spread window to spread values over a selected range of cells at the same level of the hierarchy. The spread can be horizontal or vertical.

In a horizontal spread, the values are spread from left to right. The source cells are in the leftmost column of the range.

In a vertical spread, the values are spread from top to bottom. The source cells are in the topmost row of the range.

**General Tab**

**Select a Spread Pattern**

Use the drop-down list for the Pattern field to select a spread pattern.

The following spread patterns are always available:
Even

The value in each source cell is spread evenly over the associated set of target cells. For example, if a source cell has four associated target cells, then each target cell receives 25% of the value in the source cell.

Enter weights

The value in each source cell is spread over the associated set of target cells in a way that you specify in the **Weights** section.

4,4,5, 4,5,4, or 5,4,4

These predefined patterns are available only if you are spreading across time periods. See “Spread across Time” on page 101.

Enter Weights

If you select **Enter weights** in the **Pattern** field, select one of the following in the **Weights** section:

- **Relative values**. Enter a comma-separated list of numeric weights. Each relative weight represents a percentage of the whole (100%), and target cells receive that percentage of the amount.

- **Percentages**. Enter a comma-separated list of numeric percentages in the field below the radio buttons.

  This pattern is similar to the relative weight pattern. Instead of weights, you assign a percentage of the amount to target rows or columns. Percentages must total 100%.

- **Cell references**. Click the Select Cells button to select a range of cells.

  This pattern is similar to the relative weight pattern. In this case, the weights come from a range of cells that you select from a single row or column.

In each case, if the pattern that you specify is shorter than the range of target cells, the pattern is repeated.

Spread across Time

If you spread across time periods, then the following predefined spread patterns are also available:

- 4,4,5
These predefined patterns are meaningful only if you are spreading over months and you are using the accounting convention that each month consists of either 4 or 5 whole weeks.

As with relative weights, if the pattern that you specify is shorter than the range of target cells, the pattern is repeated.

**Change the Source or Target Selection**
To modify the source or target selection, click the Select Cells button beside the **Source** or **Target** box.

**Advanced Tab**
On the **Advanced** tab, you can specify the following spread options:

**Exclude virtual children**
If this check box is selected, then a target cell that includes a virtual child member in any of its dimensions does not participate in the spread operation.

**Note:** This check box is disabled if a source cell includes a virtual child member in any of its dimensions.

**Specify how to handle existing values**
If any target cell that is not a source cell contains a preexisting nonzero value, then you must specify how to handle existing values. To do this, select this check box and one of the radio buttons below it.

- **Ignore existing values:** Overwrite existing values in the target cells.
  
  This option is not available in top-down forms.

- **Keep existing values:** If a target cell has an existing value, it does not participate in the spread operation. The source amount is spread over the remaining target cells.
- **Add existing values to spread result (but not to source amount):** Instead of overwriting the target cell, the spread results are added to the existing value of the target cell.

- **Add existing values to source amount (but not to spread result):** Any existing values in the target cells are added to the source amount. Then the spread results are written to the target cells (overwriting their existing values).

For example, suppose that a source value is spread evenly over three target cells, with values of 6, 0, 9. The first target cell (with a value of 6) is the source cell. The results are as follows:

<table>
<thead>
<tr>
<th>Option for Existing Values</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore existing values</td>
<td>2, 2, 2</td>
</tr>
<tr>
<td>Keep existing values</td>
<td>3, 3, 9</td>
</tr>
<tr>
<td>Preexisting nonzero values in target cells that are not source cells are left intact, and the entire source amount is spread over the other target cells.</td>
<td></td>
</tr>
<tr>
<td>Add existing values to spread result (but not to source amount)</td>
<td>2, 2, 11</td>
</tr>
<tr>
<td>Preexisting nonzero values in target cells that are not source cells are used in the final step of the computation. First, a set of target values is computed from the value in the source cell. Then, for any cell that had a preexisting nonzero value, the preexisting value is added to the value that was computed from the source value.</td>
<td></td>
</tr>
<tr>
<td>In the example, after the spread operation the first target cell contains 2, the second target cell contains 2, and the third target cell contains 2 + 9 = 11.</td>
<td></td>
</tr>
<tr>
<td>Add existing values to source amount (but not to spread result)</td>
<td>5, 5, 5</td>
</tr>
<tr>
<td>Preexisting nonzero values in target cells that are not source cells are used in the first step of the computation. First, all nonzero values in target cells that are not source cells are added to the source value. Then, the resulting sum is spread over the target cells.</td>
<td></td>
</tr>
<tr>
<td>In the example, after the spread operation each of the three target cells contains ((6+9)/3 = 5).</td>
<td></td>
</tr>
</tbody>
</table>
Validating Data in a Form

About Data Validation

Data validation ensures that the values in a data-entry table comply with certain constraints. For example, a company might want to make sure that employee bonuses do not exceed a specified percentage, or that new hiring does not exceed specified limits.

Note: Data validation applies only to bottom-up form sets.

Run Validation Rules

Data validation rules are automatically run when you submit a form. You can also run the rules manually at any point during data entry. To run data validation rules, follow these steps:

1. Select Data Validation.

   The Check Validation window is displayed. This window lists errors or warnings and the number of crossings in which each error or warning occurred.

   Note: Validation is run for the entire form. The rules that are applied to a data-entry table depend on the model that the table is associated with.

2. Select an error or warning and click Next or Previous to display, one by one, each crossing that fails the rule.

   Note: Some crossings might be inaccessible. For example, an analysis member might have been removed from the form, or ranking or data filtering might have temporarily hidden some crossings.

3. Make any necessary changes.
4 To perform another check, click **Re-run validation** at the bottom of the Check Validation window.

**What Is Checked**

The validation process checks all navigable crossings within each rule’s scope, except for crossings that a user has no control over. It does not check crossings that are not readable, and it does not check crossings that are protected from writing (by cell protection rules, data security, and so on).

Data validation does check crossings with server-side formulas. It also checks crossings that are protected in the form via the **Protect Cell** option. (In that case, the user could choose to unprotect the cell and correct the error.)

**Note:** A navigable crossing is one that can be displayed in the table. (It might require selecting a different slicer value or expanding a row or column.)
Working with Tables

Using the Table Pop-Up Menu .................................................. 108
Changing the View Given by a Table ........................................... 108
Pivoting a Table ........................................................................... 109
  Overview of Pivoting ................................................................. 109
  Using the Pivot Option ............................................................... 110
  Drag-and-Drop Pivoting ............................................................. 110
  Removing Dimensions with the Delete Key ............................... 111
Using Excel-Based Calculated Members ...................................... 112
  About Calculated Members ....................................................... 112
  References to Members That Are Not on the Table .................. 112
Using the Frequency Dimension .................................................. 113
Formatting Tables ........................................................................ 114
  Modifying Formats for SAS Financial Management Tables ....... 114
  Format Cells ............................................................................. 114
  Format Members ...................................................................... 115
  Modify Cell Styles .................................................................... 115
  Resolving Conflicts between Format Specifications .................. 116
Coordinating Slicers between Tables ............................................ 117
Adding Comments to a Cell ......................................................... 118
  About Cell Comments ............................................................... 118
  Add a Comment ........................................................................ 118
  View Comments ....................................................................... 119
Using the Table Pop-Up Menu

If you select any cell in a Microsoft Excel spreadsheet and click the right mouse button, a pop-up menu appears. If the selected cell is in a SAS Financial Management table, then the pop-up menu includes additional options that are provided by SAS Financial Management. The set of additional options depends on the type of table that you are working with and the type of cell that you select within the table.

Every option that is on the table pop-up menu is also on one of the menus above the workbook display. The table pop-up menu gives you an alternative way to access the options that manipulate existing tables. The dictionary of menu options includes an entry for every menu option. Each entry specifies all the ways in which the option can be accessed.

Changing the View Given by a Table

Here are some ways in which you can change the set of crossings whose values are displayed in a table:

- Double-click any underlined row heading or column heading. The underlined headings are non-leaf members of the hierarchy that they belong to. Double-clicking
an underlined heading expands or collapses the portion of the hierarchy that is subordinate to it.

- Select a **Drill, Collapse, or Expand** option.
- Select a different member of a slicer dimension, if the table has slicer dimensions. This switches the display to a slice of values that is associated with the newly selected slicer member.
- Pivot the table, using either the **Pivot** option or drag-and-drop techniques.
- Select a dimension by selecting one of its members. Then use the **Show Members** option to define a different subset of the members of that dimension to include in the table.
- Hide selected crossings using visibility rules (available only to administrators) or the **Filter Member Combination** option (available in form templates and reports).
- Use the **Table Properties** option to set a different default member for a dimension that is not part of the table layout, or to switch to a different model.

You can also filter, rank, or sort table data.

**See Also**

“Pivoting a Table” on page 109

---

**Pivoting a Table**

**Overview of Pivoting**

Any change in the role that any dimension plays in a table is a case of pivoting the table. Pivoting a table includes all of the following:

- adding a row dimension, column dimension, or slicer dimension
- removing a row dimension, column dimension, or slicer dimension
moving a dimension from one part of the table to another: from row to column or slicer, from column to row or slicer, from slicer to row or column

- changing the display order of the slicer dimensions
- changing the nesting order of the row dimensions or the column dimensions

Note: In a data-entry form, you can drag a dimension from one position to another (for example, from rows to columns). However, you cannot add or delete dimensions, and the arrows in the Pivot window are disabled.

Using the Pivot Option

To open the Pivot window: select Members ▸ Pivot.

Drag-and-Drop Pivoting

You can do many types of pivoting by dragging a table cell onto a target cell, as follows:

1. Select the dimension that you want to drag by clicking a member cell of the dimension. For a slicer dimension, you can also click the cell that holds the name of the dimension.

2. Without pressing a mouse button, move the cursor to the border of the selected cell. The directional arrow symbol appears. Make sure that this symbol is visible before you continue.

3. Press the left mouse button and drag the selected cell to a target cell.

4. When the selected cell coincides with the target cell, release the mouse button. A popup message appears, asking if you want to replace the contents of the destination cells.

5. Click OK.

The role of the dragged dimension changes as specified by the following table.
<table>
<thead>
<tr>
<th>Target Cell</th>
<th>Resulting Role of the Dragged Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>slicer cell</td>
<td>slicer dimension immediately before the slicer dimension that contains the target cell</td>
</tr>
<tr>
<td>row heading cell</td>
<td>row dimension immediately to the left of the row dimension that contains the target cell</td>
</tr>
<tr>
<td>data cell adjacent to a row heading cell</td>
<td>row dimension adjacent to the data cells</td>
</tr>
<tr>
<td>column heading cell</td>
<td>column dimension immediately above the column dimension that contains the target cell</td>
</tr>
<tr>
<td>data cell adjacent to a column heading cell</td>
<td>column dimension adjacent to the data cells</td>
</tr>
<tr>
<td>cell outside the table</td>
<td>none (dimension is removed from the table)</td>
</tr>
</tbody>
</table>

These drag-and-drop operations have the following limitations:

- The target table cell must occupy only a single Excel spreadsheet cell. A large row heading cell or column heading cell that results from nesting two or more row dimensions or column dimensions cannot be the target cell of a drag-and-drop pivot.

- If the dragged table cell occupies more than one Excel spreadsheet cell, then you must drop the first spreadsheet cell that is part of the dragged table cell onto the target table cell.

- You cannot drag a row or column dimension into a slicer dimension if the table does not already have a slicer dimension.

- You cannot drag a dimension into the last slicer position, after all existing slicers.

**Removing Dimensions with the Delete Key**

You can remove a dimension from a table in the following way:

1. Select a member of a row or column dimension, or the dimension label of a slicer dimension.
2 Press the **Delete** key.

**Note:** You cannot remove the last row dimension or the last column dimension of a table.

---

**Using Excel-Based Calculated Members**

**About Calculated Members**

You can add calculated members to a read-only table, a data-entry table, or a supplemental schedule. Each calculated member is associated with a formula that is used to calculate its values. The calculation is done after any server-side calculations.

Calculated-member formulas use the syntax of Microsoft Excel formulas. In addition to Excel functions and expressions, the formula can include the calculated-member functions that are provided by the SAS Financial Management Add-In for Microsoft Excel.

To add, delete, or edit a calculated member, click anywhere in the table and select **Members ➤ Calculated Members**.

To view the formula for a calculated member, select its heading in the table or supplemental schedule. The formula is displayed in a tooltip.

For more information, see the online Help for the calculated-member wizard and the dictionary of calculated-member functions. In addition, the *SAS Financial Management: Formula Guide* contains detailed information and examples.

**References to Members That Are Not on the Table**

Occasionally the formula for a calculated member refers to a member that is not on the table. The referenced member might be excluded because of member selection rules or property selection rules, or it might be hidden by a filter. The results are as follows:
In a read-only table or a data-entry table, the reference becomes a CDA function and continues to work correctly in Excel.

On the web data entry, the result is displayed as an empty cell.

**Note:** If the calculated member’s position refers to an excluded member, the calculated member is not displayed at all.

In a supplemental schedule, the formula is invalid. A calculated-member formula works correctly only if every member or measure that it refers to is navigable in the supplemental schedule.

---

**Using the Frequency Dimension**

The frequency dimension provides a supplementary perspective on the dimension of time. It is not a fully independent dimension. The frequency dimension is predefined and cannot be revised. It consists of a single flat set of members.

By combining a given time period with different members of the frequency dimension, you can display different but related numeric values that are associated with that time period. For example, consider a revenue account such as Total Sales and a month such as June 2010. You can combine these with various frequency members as follows:

- Combine them with Period Activity to represent total sales for June 2010. This is the default if you do not include the frequency dimension in your table.
- Combine them with Year To Date to represent total sales for the year 2010 through June 2010.
- Combine them with Quarter To Date to represent total sales for the quarter that includes June 2010, through June 2010.
- Combine them with Life To Date to represent total sales for the time span that is covered by your SAS Financial Management data, through June 2010.
Formatting Tables

Modifying Formats for SAS Financial Management Tables

You can modify the formatting in a SAS Financial Management table in these different ways:

Note: These options apply only to tables that are displayed in the SAS Financial Management Add-In for Microsoft Excel. They do not apply to tables in web data-entry forms.

- **Format Cells** applies ad hoc formatting to a selected cell or range of data cells in a table.

- **Format Members** assigns formatting styles to members. The style applies to all the data cells in the selected table with crossings that contain those members.

- **Cell Styles** applies formatting to table components including headings. This option can apply to a table, or you can create a template that applies to new reports. Using style merging, you can also apply style changes to existing reports or form templates.

You can affect the table display in other ways such as hiding slicers, selecting the display methods for zero and invalid values, and selecting whether to wrap labels. For details, see the online Help for table properties.

Format Cells

Use the Microsoft **Format Cells** option to apply ad hoc formatting to a selected cell or range of cells.

Apply this option only to data cells, not to row or column headings. Row and column headings revert to their original formatting when the display is refreshed.
To include these changes when you save the file, you must take the following additional steps:

1. Select a range of cells that includes the formatted cells.

2. Select **Attach Style Changes**.

**Format Members**

Use the Format Members window to assign cell formatting styles to members. These styles are defined in the Microsoft Excel Cell Styles window. A style that is assigned to a member is applied to all the data cells whose crossings contain that member. This style affects only the selected table.

To use this option, right-click a cell in the table and select **Members ➤ Format Members**.

**Modify Cell Styles**

**Overview**

Styles for headings and cells are defined in the Cell Styles window of Microsoft Excel. You can create new styles and apply them to the table's components, or you can modify existing styles. For example, you might want to change the font size or background color for headings, or you might want to change the color of protected cells.

On the **Styles** tab of the Table Properties window, styles can be applied to the functional components of a table such as row headings, column headings, and data cells. Notice that separate styles are assigned to row headings and drillable row headings, and to column headings and drillable column headings.

The cell styles are also available in the Format Members window.

**Save Styles in a Template**

You can save these cell styles in a template and apply them to new or existing reports and form templates. Follow these steps:
Open a SAS Financial Management report.

Open the cell styles properties (in Excel 2010, select **Home (Styles) ▶ Cell Styles**).

Modify the SAS Financial Management cell styles. For example, you might modify font colors or numeric formats. You can see the effect of any changes in the report. Do not create new styles. Instead, modify the existing styles.

With the report still open, open a new Excel workbook.

In the new workbook, select **Home (Styles) ▶ Cell Styles**.

At the bottom of the **Cell Styles** window, select **Merge styles**, and select the report with the modified styles.

The SAS Financial Management styles are copied to your new (blank) workbook.

Save the workbook as a template.

When you create new reports, begin with the template; it has your modified cell styles.

**Apply Styles to an Existing File**

To apply the cell styles to an existing report or to a form template:

1. Open the Excel template with the modified cell styles.

2. Open the report or form template.

3. Merge the cell styles from the Excel template with the styles in your report or form template.

   When you are asked if you want to merge styles with the same name, respond **Yes**.

**Resolving Conflicts between Format Specifications**

If there are conflicts in data cells between formatting that you set in these different ways, then the conflicts are resolved by the following precedence ordering:
formatting that is set with the Microsoft **Format Cells** option

2 formatting that is set with **Format Members**

3 formatting that is set with **Table Properties**

It is also possible to have conflicts within **Format Members** between members of different dimensions. These conflicts are resolved by the **Dimension Precedence** tab of the Format Members window.

---

**Coordinating Slicers between Tables**

If the same hierarchy plays the role of a slicer in two or more read-only tables or data-entry tables in the same workbook, then it is possible to connect these slicers in such a way that selecting a slicer member in one table automatically selects the same slicer member in other tables. This is a one-way relationship; a slicer in one table controls a slicer in a second table, but not the reverse.

For example, you can give the organization slicer of table Y control over the organization slicer of table Z. If a user selects Headquarters in the organization slicer of table Y, then Headquarters is automatically selected in the organization slicer of table Z. The organization slicer of table Z does not permit direct selection of organizations; it merely reflects the selections that are made in table Y.

A table can have a mix of controlling slicers and stand-alone slicers or a mix of controlled slicers and stand-alone slicers. However, a table cannot have a mix of controlling slicers and controlled slicers.

To establish a control connection between slicers in different tables:

1 Select any cell in the table that you want to put under the control of another table.

2 Select **Table Properties**.

3 In the Table Properties window, select the **Slicers** tab.
4 Use the **Shared Slicers** section of the **Slicers** tab to define the connection between tables. For details, see the online Help for the Table Properties window.

**Note:** This option is available for read-only tables and for data-entry tables in form templates.

---

### Adding Comments to a Cell

#### About Cell Comments

A cell comment consists of text that you attach to a single cell in a read-only table or a data-entry table. A cell comment is associated with the cell crossing.

**Note:** If comments are not enabled for a report or a form, you can view existing comments but you cannot add new ones.

#### Add a Comment

To add a comment to a cell:

1. Select a data cell.
   - The cell does not have to be writable, but it must be readable. You cannot add cell comments to supplemental schedules.

2. Click **Cell Comments** in the **Tools** group on the **SAS Financial Management** tab.

3. Click **Add Comment**.

4. If the comment is only for your own use, select **This comment is private**.
   - Otherwise, the comment might be available in other forms or reports.

**Note:** You cannot go back later and change the comment’s privacy setting. For example, to make a public comment private, you must delete the comment and re-create it.
5 Click **OK**.

The comment is stored, and the cell’s dimension members (other than Frequency and Currency) are included as attributes. If a dimension is off the table, the default read member for that dimension is used.

### View Comments

To view cell comments:

1. Select a cell with a red flag in its upper right corner.

   Any comments that are associated with that crossing appear in the Cell Comments window. You can leave this window open (or minimized). Its contents change as your cell selections change.

2. To view comments that are associated with subordinate members, select **Show contributing comments indicator**.

   In the table, select a cell with a blue flag in its upper left corner. All comments that are associated with any of the crossing’s subordinate members appear in the Cell Comments window.

   From the drop-down menu at the right of the comment heading, you can reply to a comment, edit the most recent comment or a reply, sort the replies, or delete comments or replies.

   **Note:** If a reply from someone else is attached to a comment, you cannot delete it. Unless you are an administrator, you can delete only comments and replies that you made.

### View the Crossing for a Comment

To view the crossing for a comment:

1. Click the **Slice to contributing crossing** button 📊.

   The display changes to reflect the crossing that is associated with this comment.
2  To display the previous crossing, click **Return to original view**.
   However, be aware that if you have modified the display (for example, by rearranging columns, rows, or slicers), clicking this button might not take you to the original view.

---

Creating and Applying Cell Styles to a Table

Creating Cell Styles

To create a new cell style that you can apply to a table:

1  Open an Excel workbook. If necessary, log on to the SAS Financial Management Add-in for Microsoft Excel.

2  On the **Home** tab, in the **Styles** group, click **Cell Styles**, and then right-click the FM custom style that you want to modify.

   ![Cell Styles Button](image)

   **TIP** If you do not see the **Cell Styles** button, in the **Styles** group, and then click the button in the lower right corner of the styles box.

3  In the **Style name** box, enter an appropriate name for the new cell style.

4  Click **Format**.

5  On the **Number**, **Alignment**, **Font**, **Border**, **Fill**, and **Protection** tabs, make the changes that you want.
6 Click **OK** to close the Format Cells dialog box.

7 Click **OK** to close the Style dialog box.

8 Create a new, or open an existing read-only or data-entry table.

9 On the **SAS Financial Management** tab, click on the table and click **Properties** in the **Tables** group.

10 On the **Styles** tab, in the **Component Styles** section, select the table component to which you want to apply the new cell from the **Table component** drop down menu. Select the new customer cell style from the **Style component** drop down menu.

11 Click **OK** to save and close the **Table** properties dialog box.

**Applying the New Cell Styles**

Once you have created the cell style, you do not need to re-create it.

To apply the new cell style:

1 Open the Excel workbook that contains the new cell style.

2 Open the file that contains the table or tables to which you want to apply the style.

3 In the workbook to which you want to apply the new cell style, on the **Home** tab, in the **Style group**, select **Cell Styles**.

4 Select **Merge Styles** at the bottom of the **Cell Styles** drop down menu.

5 From the Merge Styles dialog box, select the workbook that contains the styles that you created that you would like to merge.

6 Click **OK** to copy the cells styles into the workbook.

7 Click on the read-only or data-entry table in the workbook.

8 On the **Home** tab, in the **Tables** group, click **Properties**.
9 On the **Styles** tab, in the **Component Styles** section, select the table component to which you want to apply the different style from the **Table component** drop down menu.

10 Click **OK** to save and close the Table Properties dialog box.

11 Save your template or report to save the cell styles that you have applied.

---

**Copying a Read-Only Table to a CDA Table**

To copy the currently displayed slice of a read-only table to a CDA table:

1 Select the read-only table. To do this, click the extreme upper left cell of the table. If the table has slicers, then this is the cell that contains the name of the top slicer. If the table does not have slicers, this is the cell at the intersection of the top row of column headings and the left-most column of row headings.

   The entire table is highlighted when you select it.

2 Select **Copy as CDA**.

3 In the **Table position** field of the Copy as CDA window, enter the cell reference that will become the upper left corner of the CDA table. For example, if you want the upper left corner of the CDA table to be in cell H24, type `H24` in this field. If you want it to begin in cell B3 of Sheet2, type `Sheet2!B3`.

4 Click **OK**.

   The original read-only table remains in existence. A corresponding CDA table is created at the location that you specified.

You can also select any range of cells within a read-only table and convert the selected range to a CDA table.
Note: The **Copy as CDA** option is intended primarily for tables in which all the row, column, and slicer headings are members. If you apply it to a table that has any row, column, or slicer headings that are the values of member properties, then the resulting CDA table might be imperfect.

---

**Creating a Chart from a Table**

With the *Create Chart* option, you can create an ad hoc Microsoft Excel PivotChart from a SAS Financial Management table. The chart includes the members that are currently displayed in the table.

To create a chart:

1. Click one of the table cells.
2. Select *Edit ➤ Create Chart* from the pop-up menu.
3. Move the chart to an appropriate location in the worksheet.

As you make changes in the table (such as changing a value in a data-entry table or selecting a different slicer member), those changes are reflected in the chart.

For additional customizations, use the *PivotChart Tools* and the *PivotTable Field List* that are available when you click anywhere in the chart. For more information about working with a PivotChart, see the online Help for Microsoft Excel.

**Note:** Charts are not available in web data entry.

---

**Copying a CDA Table to a Read-Only Table**

To copy a CDA table to a read-only table:
1. Select the exact range of cells that contains the header of the CDA table. These are all the cells above the column headings that contain general information about the table.

2. Select **Copy as Read-only Table**.

   A corresponding read-only table is created in a new worksheet. The upper left cell of the new read-only table is A1. The new read-only table includes all the members of its hierarchies, regardless of any member restrictions in the source CDA table.
Data Filters, Ranking, and Sorting

Filtering Table Data ........................................ 126
About Data Filters ........................................... 126
Where Data Filters Are Applied ......................... 126
Define a Data Filter ......................................... 126
Remove a Data Filter ........................................ 127
Data Filters and Debit and Credit Accounts .......... 128

Ranking Table Data ......................................... 128
About Ranking .............................................. 128
Where Ranking Can Be Applied ......................... 128
Rank Data .................................................. 129
Rank Data within a Group ................................ 130
Remove Ranking ............................................ 130
How Rank by Percent Is Applied ....................... 130
Ranking for Debit and Credit Accounts ............... 132

Sorting Table Data ......................................... 133
About Sorting .............................................. 133
Where Sorting Is Applied ................................ 133
Sort a Column or Row .................................... 133
Sort by Group ............................................. 134
Cancel a Sort ............................................... 134
Filtering Table Data

About Data Filters

A data filter is designed to filter values in a table based on specific criteria such as the following:

- Sales > 100000
- Sales > 100000 AND GrossMargin > 10%

Data that matches the filter expression is displayed. If you combine data filters and ranking or sorting in the same table, the filter is always applied first.

Where Data Filters Are Applied

You can define a data filter for a read-only table or a data-entry table. The filter is applied to all members that the user can display (even if it requires expanding a row or column or selecting a different slicer member), as long as the members are readable.

If you apply a data filter to a data-entry table, the table becomes read-only and options such as Spread are unavailable. Removing the data filter restores the original data and the cells’ writability.

You cannot apply a data filter to a supplemental schedule or a CDA table.

Note: Web data entry honors a data filter that was created in the Excel add-in and saved via the Save Form Template or Save Form Design option. A web data entry user can temporarily remove or restore a data filter.

Define a Data Filter

To create or edit a data filter for a data-entry table or a read-only table:

1. Select a cell in the table.
**TIP** To pre-populate the data filter selections, select the heading for the row or column that you want to filter. If the heading contains nested dimensions, select the innermost dimension.

2. Select **Data Filter**.

3. In the Data Filter window, define one or more filter expressions. Multiple filter expressions must be on the same axis. They are connected by AND or OR.

For details, see the online Help for the Data Filter window.

The rows or columns that meet the filter expressions are displayed, and their hierarchies are flattened. The display might include rows or columns that were collapsed before the filter was applied. Client-side calculated members are removed from the display.

A filter icon 📊 is displayed above the row headings. Click the icon to view the filter expression in a pop-up window.

**Remove a Data Filter**

To remove a data filter expression, select **Data Filter**. In the Data Filter window, select the expression and click the Delete selected filter expression button ✖️.
To remove all filter expressions, select Data Filter. In the Data Filter window, click the Delete all filter expressions button \( \times \).

**Data Filters and Debit and Credit Accounts**

Regardless of the account balance type (credit or debit) or format (positive or negative), the filter expression contains a simple numeric comparison. A value of 100 is always considered greater than a value of -100. Define the filter accordingly.

**Note:** Your data filter can compare a debit account to a credit account. However, you cannot apply a data filter to a row or column that contains both debit and credit accounts.

---

**Ranking Table Data**

**About Ranking**

Ranking is designed to rank values in a table based on specific criteria such as the following:

- Display the bottom five regions by profit margin.
- Display products that generate the top 20% in sales.

**Where Ranking Can Be Applied**

In the Excel add-in, you can apply ranking to read-only tables or data-entry tables. The ranking is based on the values in the table’s rows and columns, including data that might not currently be visible because the user drilled down or collapsed part of a row or column. It does not include client-side calculated members, and it cannot be applied to supplemental schedules or CDA tables.

If you apply ranking to a data-entry table, the table becomes read-only and options such as Spread are unavailable. Removing ranking restores the original data and the cells’ writability.
Note: Web data entry honors a ranking that was created in the Excel add-in and saved via the Save Form Template or Save Form Design option. A web data entry user can temporarily remove or restore a ranking.

Rank Data

To create or edit a table ranking:

1. Select a table cell.

   **TIP** To pre-populate the ranking selections, select the heading for the row or column that you want to rank. If the heading contains nested dimensions, select the innermost dimension.

2. Select Rank ▶ Create Rank or Rank ▶ Edit Rank.

3. In the ranking wizard, define the dimensions and members to be ranked and the ranking expression:

   - top or bottom $n$ values: the specified number of values from the top or bottom of the ranking, in order.

     **Note:** Duplicate values, if they exist, are returned for the last item in the ranking. For example, if you rank the top three products in sales volume, and two products tie for third place, both products are displayed.

   - top or bottom $n$ percent: crossings whose cumulative values make up at least the top or bottom $n$ percent of the total value. See “How Rank by Percent Is Applied” on page 130.

The rows or columns that match the ranking expression are displayed, and their hierarchies are flattened. Client-side calculated members are removed from the display.

A ranking icon is displayed above the row headings. Click the icon to view the ranking expression in a pop-up window.
Rank Data within a Group

If the other axis for a ranking expression contains more than one dimension, you can choose to group the results by one of the outer dimensions.

For example, define a ranking expression that selects the top three products in sales, where sales is a column dimension. The row headings are region and product. You have two choices:

- You can display the top three products overall.
- You can select region as a grouping factor and display the top three products in each region.

  The Group By drop-down list determines the grouping.

Remove Ranking

To remove ranking from a table, click anywhere in the table and select Rank ▶ Remove Rank.

Note: Pivoting the table or removing members from the table might also remove the ranking.

How Rank by Percent Is Applied

If you rank data by Top n Percent of the total value, the ranking function first sorts the data from highest to lowest value. It returns the highest values whose cumulative value is greater than or equal to the percent that you specify.

Suppose that a data-entry table has a column with five values that sum to 40.00:
You rank these values, selecting the top 50% of the total value. The ranking function returns the highest values with a cumulative total that is greater than or equal to 20.00. In this case, that is a single value:

<table>
<thead>
<tr>
<th>R1002</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rent</td>
<td>2.00</td>
</tr>
<tr>
<td>Water</td>
<td>4.00</td>
</tr>
<tr>
<td>Electrical</td>
<td>8.00</td>
</tr>
<tr>
<td>Telecom</td>
<td>20.00</td>
</tr>
<tr>
<td>Repairs &amp; Maintenance</td>
<td>6.00</td>
</tr>
</tbody>
</table>

You edit the ranking, selecting the bottom 50% of the total value. The ranking function returns the lowest values with a cumulative total that is greater than or equal to 20. In the data-entry table, the displayed cells would look like this:

<table>
<thead>
<tr>
<th>R1002</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rent</td>
<td>2.00</td>
</tr>
<tr>
<td>Water</td>
<td>4.00</td>
</tr>
<tr>
<td>Repairs &amp; Maintenance</td>
<td>6.00</td>
</tr>
<tr>
<td>Electrical</td>
<td>8.00</td>
</tr>
</tbody>
</table>

Now assume that the column to be ranked contains negative values as well as positive values:

<table>
<thead>
<tr>
<th>R1002</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rent</td>
<td>(2.00)</td>
</tr>
<tr>
<td>Water</td>
<td>4.00</td>
</tr>
<tr>
<td>Electrical</td>
<td>6.00</td>
</tr>
<tr>
<td>Telecom</td>
<td>(1.00)</td>
</tr>
<tr>
<td>Repairs &amp; Maintenance</td>
<td>3.00</td>
</tr>
</tbody>
</table>
The total value is 10. You select the top 100% of the total value. The ranking function returns the highest values with a cumulative total that is greater than or equal to 10. The displayed cells would look like this:

<table>
<thead>
<tr>
<th>R1002</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical</td>
<td>6.00</td>
</tr>
<tr>
<td>Water</td>
<td>4.00</td>
</tr>
</tbody>
</table>

It might seem counterintuitive that selecting 100% does not return all the values. However, the 100% mark (10) is reached with just the values of 6 and 4.

**Note:** If the total for the row or column is zero, no results are returned.

**Ranking for Debit and Credit Accounts**

- **Debit accounts:** If ranking is applied to debit accounts, the top-ranked values are the ones with the highest debit values, regardless of how those values are displayed (as defined in the model or table properties).

  By default, debit accounts display a positive debit balance using positive numbers. If the row or column being ranked contained values of 20, 30, 10, -10, -5, 0, 10, a ranking of the top three values would return 30, 20, 10, 10, with a tie for third place.

- **Credit accounts:** If ranking is applied to credit accounts, the top-ranked values are the ones with the highest credit values, regardless of how those values are displayed.

  By default, credit accounts display a negative credit balance using negative numbers. If the row or column being ranked contained values of -10, 5, -30, 0, -20, a ranking of the top three values would return -30, -20, -10.

**Note:** You cannot apply ranking to a row or column that contains both debit and credit accounts.
Sorting Table Data

About Sorting

The Sort option enables you to sort table data by the values in a single row or column. It can be used for purposes such as the following:

- Display total sales in descending order.
- For each region, display cost of sales in ascending order.

Where Sorting Is Applied

Sorting can be applied to read-only tables or data-entry tables. It does not include client-side calculated members, and it cannot be applied to supplemental schedules or CDA tables.

If you apply a sort to a data-entry table, the table becomes read-only and options such as Spread are disabled. Removing the sort restores the original order and the cells’ writability.

Note: Web data entry honors a sort that was created in the Excel add-in and saved via the Save Form Template or Save Form Design option. A web data entry user can temporarily remove a sort or create another sort.

Sort a Column or Row

To sort a table by the values in a row or column:

1. Make sure that all the members that you want to display are on the table.
   The sort applies only to members that are currently displayed.

2. Right-click a row or a column heading and select Sort ▶ Ascending or Sort ▶ Descending.
If there is more than one row or column dimension, select a member of the innermost dimension.

The display is sorted according to the values in that row or column, and the hierarchies in that dimension are flattened. A sort direction icon (such as 🔄) indicates whether the sort is ascending or descending.

If a cell is not readable, it appears as an empty cell at the end of the sorted row or column. Client-side calculated members also appear as empty cells at the end of the sorted row or column.

**Sort by Group**

If the table groups the display by using two or more row or column dimensions, you have the option of sorting data within members of a nested dimension.

For example, create a table with two row headings, *My_Product* and *Customer*, and one column heading, *My_Account*. *My_Product* is the outer row heading and groups the display.

Right-click a member of the *My_Product* dimension and select **Sort ➤ Ascending ➤ By My_Product**.

The column is sorted within each account. If you select **Sort ➤ Ascending ➤ None**, the sort applies to the entire column.

**Note:** Member properties and custom properties cannot be used as grouping criteria. The sort-by functionality is not available if a data filter is applied to the table.

**Cancel a Sort**

To cancel a sort, right-click any row or column heading and select **Sort ➤ None**.
A sort is also canceled if you create another sort or if you remove the sort member from the display (for example, by pivoting or by collapsing the hierarchy).
Cell Protection

**About Cell Protection**

When cell protection is applied, a cell is protected from direct data entry, including actions such as the following:

- manual data entry
- spread
- the effects of writing to parent members

However, the values of these protected cells can still change as the result of indirect actions, including the following:

- calculations
- changes in the values of descendants that roll up to the protected cell
- changes in exchange rates
- changes in previous periods when frequency is To Date (for example, Year To Date or Quarter To Date)
- data that is loaded via SAS Data Integration Studio jobs
data that was seeded from other models

rules-based adjustments and allocations

manual adjustments

Note: For information about protection by means of hold rules, see “Data Entry with Hold Rules” on page 95.

Adding Cell Protection Directly to a Form

In a data-entry table, protected cells are displayed in gray and are read-only.

If cells are protected by rules that were defined in a model or a form template, you cannot undo that protection in an individual form. However, you can add further protection to a form, as follows:

- To protect one or more cells, select the cells and select Protect Cell. Only writable cells can be protected.

- To undo protection that was set in this form for one or more cells, select the cells and select Unprotect Cell.

- To undo all cell protection that was set in this form, click anywhere in the table and select Unprotect All Cells.

The changes that you make are saved automatically and apply to any users who open the same form.

Note: Protection that you apply to a parent member also applies to its virtual child (VC member), and vice versa.
Designing Holds for Data-Entry Forms

Overview

Note: This feature applies only to bottom-up form sets.

If you place a hold on a cell in a data-entry table, it is protected from changes such as allocations and consolidations. For example:

- If the hold is on a leaf cell and its parent cell is writable, the hold is honored and the leaf cell receives no allocation from the parent.
If the hold is on a parent cell, its descendant cells might change in value, but the total that rolls up to the parent is unchanged. Instead, the change in value is subtracted from the other descendant (leaf) cells.

If one of the leaf cells also has a hold, its hold is honored, and it does not participate in the distribution to the descendant cells.

Cells that are on hold are not protected from actions such as users entering a value, copying, and pasting, the **Spread** and **Adjust Values** options, and entering data in a supplemental schedule. To protect a cell from those types of changes, use cell protection rules. Cells on hold are also not protected from the results of forecasts or custom analytics stored processes.

You cannot place a cell on hold if a formula is attached to it.

### Enabling Hold Rules

An administrator enables hold rules in the table properties of a form set template. The rules specify the dimensions and levels within which holds can be placed.

Each table has its own hold rules. However, a hold that is created in one table applies to another table in the same form, if the following conditions are true:

- the other table uses the same model
- the other table enables hold rules
- the other table’s hold rules include the cell with the hold

For a detailed explanation of setting hold rules, see the online Help for the table properties.

### Who Can Place a Hold

If **Allow Hold Rules** is set in the table properties, cells can be placed on hold in a form or a form template.

- In a form template, an administrator can enable and define hold rules, place cells on hold, and remove holds.
- In a form, users can place and remove holds.
The holds persist without selecting **Save Form Design**.

Users cannot remove holds that are placed in the form template, and they cannot enable or disable hold rules.

The cell’s color indicates that it is being held. See “Entering Data” on page 92.

**Placing a Hold**

To place one or more cells on hold, select the cells and select **Holding ➤ Hold Value**.

To remove the hold from one or more cells, select the cells and select **Holding ➤ Unhold Value**.

To remove all holds, select **Holding ➤ Unhold All**.

**Hold on a Parent Cell**

Suppose that you place a hold on a cell that is associated with a parent member. When a user enters a value in a descendant of that member, the change in value is distributed among the other eligible descendants. Higher members of the hierarchy are not affected.

The amount that is distributed to a cell depends on its relative weight. If automatic allocation ( Allocate from parent members other than time using predefined weights) is enabled, the cell weights depend on the Allocation Weights table when you write to a parent cell. Otherwise, each cell’s value acts as its weight. In this case, automatic allocation is not enabled.

If a cell has a weight of zero, it receives no distribution.

For an example, see “Example: Hold on Parent Member” on page 96.

**Hold on a Leaf Cell**

As another example, suppose that automatic allocation is enabled. The allocation weights are **Same as target**. A leaf cell is being held.
When a user writes to the parent cell, its value is allocated to its writable descendants, except for the cell that is on hold.

<table>
<thead>
<tr>
<th>Operating Expense</th>
<th>17.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative Expense</td>
<td>17.00</td>
</tr>
<tr>
<td>Office Supplies</td>
<td>2.00</td>
</tr>
<tr>
<td>Postage</td>
<td>1.00</td>
</tr>
<tr>
<td>Other Administrative Expense</td>
<td>0.00</td>
</tr>
<tr>
<td>Facilities</td>
<td>14.00</td>
</tr>
<tr>
<td>Rent</td>
<td>8.00</td>
</tr>
<tr>
<td>Water</td>
<td>2.00</td>
</tr>
<tr>
<td>Electrical</td>
<td>2.00</td>
</tr>
<tr>
<td>Telecom</td>
<td>2.00</td>
</tr>
<tr>
<td>Repairs &amp; Maintenance</td>
<td>0.00</td>
</tr>
<tr>
<td>Other Facilities Expense</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Holds on a VC Cell**

Placing a hold on a parent cell does not affect its virtual child (VC). If you place a hold on a VC cell, you can write directly to the VC cell, but it cannot receive a distribution from the parent.

For example, you enable writing to parent cells, with data stored in the parent’s VC member. If the parent cell is held, you can write directly to the parent, and the change in the parent’s value is added to the VC member. In contrast, if the VC cell is held, it is protected against indirect changes, and a write to the parent fails,
Protected Cells

Cell protection protects a cell from direct changes. If hold rules are enabled, and a protected cell lies within the scope of the hold rules, the cell is also protected from indirect changes as described in the “Overview” on page 139. The cell’s color changes to indicate that it is being held as well as protected.

Side Effects of Hold Rules

Hold rules can have side effects for cells that were not affected by the initial data entry.

Suppose you place holds on two parent cells in different dimensions. A user enters a value in a child of Parent A that causes a distribution to other leaf cells in one dimension. Some cells in the distribution would normally roll up to Parent B in the other dimension. Because Parent B is also on hold, a second distribution occurs. If additional cells are on hold, there can be a cascading effect of distributions.

To illustrate this case, red boxes have been added to outline the ranges for the two holds. Notice the overlap at the Rent/R1001 cell.

<table>
<thead>
<tr>
<th>Operating Expense</th>
<th>R1001</th>
<th>R1002</th>
<th>R1003</th>
<th>R series</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative Expense</td>
<td>8.00</td>
<td>6.00</td>
<td>8.00</td>
<td>22.00</td>
</tr>
<tr>
<td>Office Supplies</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>3.00</td>
</tr>
<tr>
<td>Postage</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>3.00</td>
</tr>
<tr>
<td>Other Administrative Expense</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>3.00</td>
</tr>
<tr>
<td>Facilities</td>
<td>5.00</td>
<td>3.00</td>
<td>5.00</td>
<td>13.00</td>
</tr>
<tr>
<td>Rent</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>3.00</td>
</tr>
<tr>
<td>Water</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>3.00</td>
</tr>
<tr>
<td>Repairs &amp; Maintenance</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>3.00</td>
</tr>
<tr>
<td>Telecom</td>
<td>1.00</td>
<td>0.00</td>
<td>1.00</td>
<td>2.00</td>
</tr>
<tr>
<td>Other Facilities Expense</td>
<td>1.00</td>
<td>0.00</td>
<td>1.00</td>
<td>2.00</td>
</tr>
</tbody>
</table>

You enter a 5 in the Water/R1001 cell. The first distribution is for the Operational Expense/R1001 hold, because Water is a descendant of Operational Expense.

However, those changes affect the Rent/R1001 cell, and R1001 is a descendant of R series. A second distribution is necessary and affects Rent/R1002 and Rent/R1003. The result is below:
Hold Rules and Dimension Precedence

In these cascading distributions, a cell can be used only once. After a cell has been updated by one distribution, it cannot be updated by another distribution as part of the same Write operation. For the write to succeed, there must be enough available cells to handle all necessary distributions.

You can use dimension precedence to affect the order in which the distributions occur and the number of cells that are affected by a distribution. Distributions take place in this order:

1. cells that are directly affected by the initial write to parent or child cell:
   a. the first dimension in the hold rules, from lowest to highest level
   b. the next dimension in the hold rules, and so on

2. cells that are not directly affected by the initial write, but are affected by the distribution process:
   a. the first dimension in the hold rules, from lowest to highest level
   b. the next dimension in the hold rules, and so on

Here is an example with two held parent members:

<table>
<thead>
<tr>
<th>Operating Expense</th>
<th>R1001</th>
<th>R1002</th>
<th>R1003</th>
<th>R series</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative Expense</td>
<td>8.00</td>
<td>6.29</td>
<td>8.29</td>
<td>22.57</td>
</tr>
<tr>
<td>Office Supplies</td>
<td>0.43</td>
<td>1.00</td>
<td>1.00</td>
<td>2.43</td>
</tr>
<tr>
<td>Postage</td>
<td>0.43</td>
<td>1.00</td>
<td>1.00</td>
<td>2.43</td>
</tr>
<tr>
<td>Other Administrative Expense</td>
<td>0.43</td>
<td>1.00</td>
<td>1.00</td>
<td>2.43</td>
</tr>
<tr>
<td>Facilities</td>
<td>6.71</td>
<td>3.29</td>
<td>5.29</td>
<td>15.29</td>
</tr>
<tr>
<td>Rent</td>
<td>0.43</td>
<td>1.29</td>
<td>1.29</td>
<td>3.00</td>
</tr>
<tr>
<td>Water</td>
<td>5.00</td>
<td>1.00</td>
<td>1.00</td>
<td>7.00</td>
</tr>
<tr>
<td>Repairs &amp; Maintenance</td>
<td>0.43</td>
<td>1.00</td>
<td>1.00</td>
<td>2.43</td>
</tr>
<tr>
<td>Telecom</td>
<td>0.43</td>
<td>0.00</td>
<td>1.00</td>
<td>1.43</td>
</tr>
<tr>
<td>Other Facilities Expense</td>
<td>0.43</td>
<td>0.00</td>
<td>1.00</td>
<td>1.43</td>
</tr>
</tbody>
</table>
The user enters 20 into the Postage/R1001 field. This value directly affects both holds.

If Product comes before Account in dimension precedence, the distribution is first applied to the Operating Expense/R1001 cell and affects only the first column in the table. The red rectangular areas show where the distribution occurs.

Results are as follows:

In contrast, if Account comes before Product in dimension precedence, the distribution for Administrative Expense/R series takes place first. That distribution affects all the available leaf cells:
There are no available cells left for the Operating Expense/R1001 distribution, and the Write operation fails.

For information about setting dimension precedence, see the online Help for the Hold Rules tab in the table properties.

**Errors**

Each stage of the process needs at least one writable cell to receive an allocation or distribution. If all eligible cells are protected from writing, the process fails. If all eligible cells have a weight of zero, or if the sum of all eligible cells (the total weight) is zero, the process fails. A pop-up message displays the error.
Entering Data into a Supplemental Schedule

Overview

A form can include one or more supplemental schedules, which provide additional information to support data entry. Each supplemental schedule is associated with a data-entry table and can contain two types of measures:

- measures that correspond to members of the data-entry table.
- custom measures that were designed for use in a supplemental schedule. These measures might be numeric, or they might contain character strings, dates, or true or false values.

You can recognize a supplemental schedule by its last rows, which display column totals and averages in green cells. The corresponding crossings in the data-entry table
are also displayed in green. The cell information for these cells also explains their use in supplemental schedules.

**Enter Data in a Supplemental Schedule**

**Bottom-Up Forms**

In a bottom-up form, entering data into a supplemental schedule is like entering data into a data-entry table. You enter data in writable (yellow) cells of detail records for a specific member of the data-entry table. For example, the detail records might be associated with the organization dimension. When you open the form, only the detail records for your organization member (or members) are displayed.

At the bottom of the supplemental schedule are two rows that display totals and averages for the detail records. If a measure is also a member of the data-entry table, its total is saved in the corresponding crossing in the data-entry table when you save the supplemental data. (The **Detail averages** row is provided only for reference.)

**Top-Down Forms**

In a top-down form, the supplemental schedule contains a green **Non-allocated** row. This row displays the amount from the data-entry table that remains to be allocated in the supplemental schedule. You can distribute that amount among the detail records in the supplemental schedule. (For the top-level member of the target hierarchy, this row is empty.)

No data entered in a supplemental schedule is saved to the data-entry table in a top-down form. The supplemental schedule for a top-down form enables you to create supplementary records that contain more detail than would be available in the data-entry form.

**Add a Detail Record**

In addition to entering data into existing rows, you can add new detail records. For example, if the forms are being used for a budgeting process, each new detail record might represent a planned (but not yet hired) employee.
To add a row to a supplemental schedule, right-click a row heading and select **New Detail**. In the New Detail window, respond to the following prompts:

**Code, Name, and Description**

Enter a code, name, and description for the new detail record. The name appears in the row heading for the new record.

If you enter a code that already exists, a subscript is added when you click **OK**. For example, “MyDetail” might become “MyDetail[2]”.

**Select the scope for this detail**

This prompt appears only if the form set designer did not already set the scope for all detail records. Select one of the following:

- **Make it available to other form sets.**
  The detail record is available to any forms that have the same detail dimension.

- **Limit its availability to this form set.**
  The detail record is available to any forms in this form set.

**Prompts for measures**

Depending on form set design, you might be prompted to enter or select initial values for some of the custom measures. These fields are optional.

Some custom measures are subject to validity checks. For example, a numeric value or a date might need to fit within a specific range. If the value that you enter does not pass a validity check, an error symbol is displayed above the prompt. An error message is displayed in a tooltip for the error symbol.

**Note:** The **Reset group defaults** link resets all prompts to their default values.

The following functions are also available for working with detail records:

- To modify the name and description of a detail record, right-click its row heading and select **Edit Detail**. (You cannot edit the member code.)
- To delete a detail record, right-click its row heading and select **Delete Detail**.
- To copy and paste values between detail records, select one or more records and select **Copy Detail Values**. Then select the destination records (within the same supplemental schedule) and select **Paste Detail Values**.
Save the Supplemental Data

After you enter data into a supplemental schedule, click **Save All Supplemental Data**. The option affects all supplemental schedules in the form.

In a bottom-up form, **Save All Supplemental Data** saves the totals for numeric measures to the related crossing in the source data-entry table. (Custom measures are not saved to the data-entry table.)

For a top-down form, no data is saved to the data-entry table. However, for both bottom-up and top-down forms, the supplemental schedule data is saved to the supplemental data provider’s database. This data is available when you select **Contributing Data** for a cell.
Generating a Forecast

Overview

In a form template, an administrator can generate a forecast that is based on the historical data in the model for the data-entry table. The Forecast wizard uses SAS High-Performance Forecasting to generate the forecast data.

The forecasting software uses sophisticated automatic model selection techniques to choose the best-fitting model for the data. After a successful forecast is complete, this model is stored on the server and can be reused for more efficient forecasting. The forecast parameters are saved with the form template.

If forecasting is enabled for data entry, a user who is editing a form can also generate a forecast. The user’s forecast can reuse the model or request to have a new model generated. However, a forecast model that is generated from a form is not saved.

For details, see the online Help for the Forecast wizard.

Note: Forecasting is available only in forms without supplemental schedules.
Execution Time

The time it takes a forecast to execute depends primarily on these factors:

- the number of by-variable members that are selected
- the number of historical and forecast time periods
- whether the forecast model is reused

Because execution time can be lengthy, a forecast runs asynchronously and sends a notification when the forecast completes.

If you have not closed the form or template, a pop-up message appears when the forecast completes. To view the results, refresh the display.

Forecast Results

The forecast results are written to the analysis member that was selected for the forecast. If you selected **Use confidence values**, then two additional members, for the upper bound and lower bound of the confidence interval, also hold forecast results.

**Note:** Writing the forecast results, like other data entry operations, causes driver formulas to be executed.

After generating a forecast, you can use the **Create Chart** option to create a Microsoft Excel PivotChart to display the results in Microsoft Excel. See “Creating a Chart from a Table” on page 123. You can also use Excel’s copy and paste functionality to copy forecast results to another part of the table. For example, you might copy the forecast data or the lower bound data to the Budget member.

The object type for forecast-generated data is **forecast** and can be seen if you view contributing data for a crossing.

In SAS Financial Management Studio, the cycle properties contain a history record of the forecast. If the forecast failed, the record contains a link to a detailed report.
Index

A

active processes
  adding a comment 68
automatic tasks 65
disabling a task 67
enabling a task 67
failed tasks 66
manual tasks 66
prompted tasks 66
rescheduling a task 66
running a task 65
task status 64
tasks 62
viewing 61
  viewing task history 68
Adjust Values 38
Adjust Values option 98
alert notifications
  for forms 8
alerts 79
Alerts portlet 8
Allocate option 91
allocation in a top-down workflow 91
approving
  forms 18
attachments
  opening 17

B

bottom-up form status 18
bottom-up workflow 18
  entering data in Excel 91
  reviewing data in Excel 97

C

calculated members 112
capabilities
  for working on forms 10
CDA tables
  copying from read-only tables 122
  copying to read-only tables 123
cell comments 41, 118
cell formats 114
  resolving conflicts 116
cell information 28
Cell Information option 92
cell protection 92, 138
cell styles
  modifying 115
saving in a template 115
charts, creating 123
Check In Form option 97
Check Out Form option 97
Collapse option 108
color-coded cells 28, 92
comments
attached to cell crossings 118
attached to forms 16
Copy and Paste options 92
Copy as CDA option 122
Copy as Read-only Table option 123
Copy Cells 32
Create Chart option 123
crossings 25

data entry
automatic allocation 30
parent cells 30
pasting multiple times 92
data filter
removing 127
Data Filter option 126
data filters 43
data validation 47
data-entry tables
calculated members 112
cell protection 138
pop-up menu 108
deadline 12
detail records
in supplemental schedules 50
dimensions 25
display size
increase or decrease 8
Drill Down option 108
Drill Up option 108

E

editing
forms 18, 19
editing forms 24
Excel data entry 90
bottom-up form sets 91
color-coded cells 92
parent cells 94
saving data 93
supplemental schedules 147
top-down form sets 91
virtual children 94
Expand All option 108
Expand option 108

F

Filter Member Combination option 108
filtering data 126
Filters option 108
Forecast wizard 151
forecasting 151
failure report 152
results 152
form actions 15
form sets 4
  attachments 17
  overview 17
  types 17
form status
  portlet 77
Form Status Dashboard portlet 77
form types 12
Format Cells option 114
Format Members window 115
formats for table cells 114
forms 4
  alert notification 8
  alerts 79
  approving 18
  attachments 17
  bottom-up workflow 18, 91
  checking in 97
  checking out 10, 97
  comments 16
  data entry 28
  deadline 12
  editing 18, 19, 91
  history 14
  member 12
  name 12
  opening for web data entry 10
  opening in Microsoft Excel 10
  overdue 12
  pushing 19
  recalling 18, 19
  rejecting 18
  reviewing 18, 97
searching the list 13
  sorting the list 13
status 18, 20
submitting 18
submitting parent forms 18
supplemental schedules 147
top-down workflow 19, 91
type 12
  view available 9
forms display 12
Forms workspace 4
  attachments 17
  bottom-up form status 18
  columns 12
  data entry 24
  form actions 15
  form comments 16
  grid view 10
  hierarchy view 10
  history 14
  layout 5
  opening 9
  saving search criteria 14
  searching 13
  sending e-mail messages to authors and reviewers 14
  sorting the list of forms 13
  tasks 9
  top-down form status 20
  workflow 15
forms, editing
  See Excel data entry
  See offline data entry
  See Web data entry
Frequency dimension 113
<table>
<thead>
<tr>
<th>G</th>
<th>Paste Cells</th>
<th>32</th>
</tr>
</thead>
<tbody>
<tr>
<td>green cells</td>
<td>pasting multiple times</td>
<td>92</td>
</tr>
<tr>
<td>H</td>
<td>Pivot option</td>
<td>108, 109</td>
</tr>
<tr>
<td>hierarchies</td>
<td>pivoting tables</td>
<td>109</td>
</tr>
<tr>
<td>hold rules</td>
<td>Preferences</td>
<td>95</td>
</tr>
<tr>
<td>designing</td>
<td>in portal</td>
<td>139</td>
</tr>
<tr>
<td>I</td>
<td>process management</td>
<td>8</td>
</tr>
<tr>
<td>information maps</td>
<td>See also</td>
<td>active processes</td>
</tr>
<tr>
<td>L</td>
<td>alert notifications</td>
<td>60</td>
</tr>
<tr>
<td>linking slicers</td>
<td>process managers</td>
<td>59</td>
</tr>
<tr>
<td>N</td>
<td>process viewers</td>
<td>59</td>
</tr>
<tr>
<td>New Detail</td>
<td>Protect Cell option</td>
<td>50</td>
</tr>
<tr>
<td>notification type</td>
<td>protected cells</td>
<td>138</td>
</tr>
<tr>
<td>O</td>
<td>pushing</td>
<td>92</td>
</tr>
<tr>
<td>offline data entry</td>
<td>forms</td>
<td>19</td>
</tr>
<tr>
<td>P</td>
<td>Rank option</td>
<td>128</td>
</tr>
<tr>
<td>parent cells</td>
<td>ranking</td>
<td>43</td>
</tr>
<tr>
<td>entering data</td>
<td>ranking table data</td>
<td>128</td>
</tr>
<tr>
<td>N</td>
<td>read-only tables</td>
<td>128</td>
</tr>
<tr>
<td>New Detail</td>
<td>calculated members</td>
<td>112</td>
</tr>
<tr>
<td>notification type</td>
<td>collapsing</td>
<td>108</td>
</tr>
<tr>
<td>O</td>
<td>copying CDA tables to</td>
<td>123</td>
</tr>
<tr>
<td>offline data entry</td>
<td>copying to CDA tables</td>
<td>122</td>
</tr>
<tr>
<td>P</td>
<td>expanding</td>
<td>108</td>
</tr>
<tr>
<td>parent cells</td>
<td>filtering</td>
<td>108</td>
</tr>
<tr>
<td>entering data</td>
<td>pivoting</td>
<td>108</td>
</tr>
<tr>
<td>N</td>
<td>pop-up menu</td>
<td>108</td>
</tr>
<tr>
<td>New Detail</td>
<td>recalling</td>
<td>19</td>
</tr>
<tr>
<td>notification type</td>
<td>forms</td>
<td>19</td>
</tr>
<tr>
<td>O</td>
<td>Refresh All option</td>
<td>93</td>
</tr>
<tr>
<td>offline data entry</td>
<td>Refresh option</td>
<td>93</td>
</tr>
</tbody>
</table>
rejecting forms 18
reports 80
  opening 54
  searching 54
types 53
  viewing 88
Reports workspace 53, 54
  organizing folders 56
reviewing
  forms 18, 97
roll-ups 29

S

SAS Financial Management
log on 75
  web preferences 8
SAS High Performance
  Forecasting 151
SAS Information Delivery Portal
  SAS Financial Management
    content 76
SAS reports 76
Show Members option 108
slicers 26
  linking between tables 117
  selecting 27
sort by group 134
Sort option 133
sorting 43
  by group 134
  canceling a sort 134
tables 133

spread
  horizontal 32
  vertical 32
  spread option 32
Spread option 100
spreading
  over protected cells 38
standard reports 80
stored processes 76, 80
styles for formatting table cells 114
submitting
  forms 18
supplemental schedules
  calculated members 112
detail records 50
entering data 49, 147
saving data 49, 51, 147

T
table cells
  formatting 114
Table Properties option 108
tables
  data filters 126
  ranking 128
  sort by group 134
  sorting 133
target hierarchy 4
top-down form status 20
top-down workflow
  entering data in Excel 91
steps 19
V
validation rules 47
virtual children 30, 94

W
Web data entry 24
  adjusting values 38
  cell comments 41
  cell information 28
  copying and pasting cells 32
  crossings 25
  dimensions 25
  drilling down 27
  expanding rows and columns 27
  form headers 26
  headers 26
  hierarchies 29
  refreshing 29
  roll-ups 29
  rows and columns 26
  Select Member window 27
  slicers 26, 27
  supplemental schedules 49
  virtual children 30
  writable cells 28
  workflow 15
  writable and non–writable cells 28

Y
yellow cells 91